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Introduction

Welcome

The Financial Support Services Unit (FSSU), established by the Department of
Education under Circular M36/05, provides support and training to schools in the
Voluntary Sector on all aspects of school finances. Our goal is to ensure schools have a
robust and supported computerised accounts package, enabling school management
and Trustees/Patrons to meet their financial accountability obligations for State and other
funding.

Since the transition from TAS in 2014, Sage 50 Accounts has proven to be a reliable
and robust accounting solution for schooals. It is a desktop-based system that combines
stability with modern enhancements. Key new features include:

@® Remote Data Access: Enables secure, real-time collaboration for authorised users,
making remote working and communication with finance teams and accountants
seamless.

® Bank Feeds: Automatically imports bank transactions into the software, reducing
manual input and allowing for faster, more efficient bank reconciliations.

We are confident that Sage 50 Accounts continues to meet all requirements, providing
assurance and confidence to our schools. Full support and training from the FSSU will
remain available on an ongoing basis.

Financial Support Services Unit
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1.1 Install Sage 50 Accounts software

1.1.1 Install Sage 50 Accounts on a single computer

m Before you start your installation please ensure you close all software.

1. Have your serial number, activation code and account number at hand. This information is
available under Help/About.

2. Download the latest version of Sage 50 Accounts - Full Program
3. Run the program as administrator to install the software

4. Select Upgrade installation (Recommended).

Sage 50 Accounts

Select where you want to install 0 Help
«/ Upgrade installation (Recommended) Install to new location
To upgrade a currently installed version of Install Sage 50 Accounts to a new location.
Sage 50 Accounts, install the new version in Only choose this if you must retain the old
the existing location. Please ensure you have a version as a separate installation, in addition
current backup of all companies before to the new version.
proceeding.

Sage 50 Accounts v30 has been found in the following location:

C:\Program Files\Sage\Accounts\

Your Software Licence Agreement (Terms) relating to your use of Sage 50 Accounts can be found here. By pressing the button
below you indicate that you agree to the Terms. If you don't accept the Terms then please contact us or your supplier and do
not install the software.

Cancel & Accept Licence Agreement & Install

5. Click Accept Licence Agreement & Install
6. Installation will run and complete

7. Launch Sage 50

Congratulations, the installation is complete and you're now ready to setup your New Sage
software.
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1.1.2 Registration

When you open Sage 50 Accounts for the first time, the Sage 50 Accounts Software
Registration window appears.

Sage 50 Accounts - Software Registration | & |

Activate Sage Software

Activation Information

Serial Mumber; | |

Activation Key: | |

To activate your software you must enter your serial number
and activation key. These can be found on the advice note
you received with the software, or within the DVD case.

If you can't find your serial number or activation key, dick on
the My Sage button to assist you in finding this information.

If you are unable to find your details using this service, you
can speak to an advisor on 18390 88 20 60,

MySage | | Continue | | Cancel

j For assistance, please email fssuqueries@sage.com

Enter the serial number and activation key provided with your software » Continue.

@ Congratulations, you've now successfully registered your software

¢ TABLE OF CONTENTS 8
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1.2 Install Sage 50 Accounts on a network

If you have a computer in the office which is already connected to the school server by other
software you should install Sage 50 Accounts on the server. The server computer normally
has the software installed on it and also stores the data files, the office computer has the
software installed, but connects to the server for the data. The software must be installed on
the office computer and the server.

1.21

1.2.2

Install Sage 50 Accounts on a server computer

The steps to install the software on your server computer are exactly the same as
installing on a single computer, simply follow the steps in the previous section.

Share a folder on your server computer

To link your office computer to the data on your server computer you must first share a
folder on the server, making it visible to the rest of the network.

The folder you need to share is located as follows:
C:\ProgramData\Sage\Accounts\20xx

The steps to share a folder on the server computer differ depending on the operating
system. In all cases the folder needs to have full control of the Share, and Modify
permissions on the folder contents.

If you're unsure how to do this, consult your IT administrator, the Windows help system,
or email Sage Technical Support at fssuqueries@sage.com.
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1.3 Installing FSSU Chart of Accounts (where you are
moving to Sage 50 Accounts from another software package/
excel / manual recording)

1.

Once you have installed the Sage 50 software you will need to setup a data set for your school.

The FSSU has created a standard company modified for schools and we recommend that
you use this standard company to set up your school on the SAGE 50 accounts system.

This dataset is available on our website here.

FSSU > Post-Primary > Topics > Sage 50 Accounts > Sage 50 Info > Getting Started in Sage 50 PRINT

All Topics Getting Started in Sage 50

Accounting Procedures & Controls Once you have installed the Sage 50 software you will need to setup a data set for your school.

Adult Education The FSSU has created a standard company modified for schools and we recommend that you use
this standard school file in this dataset to set up your school on the SAGE 50 accounts.

After School Study

Download FSSU School file

Asset & Stock (right click on link and select Save link as)

Guide on Installing School file

S

Right click on Download FSSU school file and select Save link as and save to the desktop 3.
Open sage 50 and click on Add, Select restore a Company from a backup and follow onscreen
instructions.

The following section outlines the key options for adding a Company into Sage
50 in particular where Sage 50 is being moved to a new PC or laptop
Launch Sage 50 to set up the Sage 50 accounts for the relevant data set.

To add a Company there are 4 options shown below.

Add a Company

Select an option to add a company to your list.
Create Connect v Restore Download
Create a new Open a company Restore a company Use Remote Data
company in from a network from a backup. Access to download
Sage 50 Accounts. location. a company.

Browse to your backup file

’ C:\ProgramData\Sage\Accounts\2026\ ‘ | Browse |

Your company data will be created in the following location

’ C:\Programdata\Sage\Accounts\2026\Company.001 ‘ | Change |
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The two key options will be:
Option 1: Click on Restore from a backup.

Click on Browse and select the relevant Sage data backup that you want to restore.

= e.g. FSSU dataset from step 2 above where you are starting off with Sage 50 for the
school accounts.

= Orthe latest data backup where you are moving Sage 50 to a new PC.

Click continue.
Click Restore
Finish

Option 2: Download: Use remote data access to download a company

Ensure the administrator has granted the username access to the data and that you know
the encryption password for the dataset. You should also have a Sage account which

is the online account you use to access Sage services, including Remote Data Access

(RDA) in Sage 50 Accounts. It is for your login to Sage's cloud-based features.

Select download from the Add Company screen.

Add a Company

Select an option to add a company to your list.

Create Connect Restore v/ Download
Create a new Open a company Restore a company Use Remote Data
company in from a network from a backup. Access to download
Sage 50 Accounts. location. a company.
Your company data will be created in the following location
C:\Programdata\Sage\Accounts\2026\Company.001 ‘ | Change

Follow the onscreen instructions to activate.

There is further information on activating remote data access in section 1.11 below.
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1.4 Installing FSSU Board of Management Reports

The FSSU has created a standard set of Board of Management reports which have to be
downloaded and saved into the Sage 50 software. These reports will then be available to run
for monthly reporting purposes.

The recommended reports which are available here to download from
our website are:

1. Profit & Loss Report (budget v actuals) & | year past
2. Balance Sheet Report

3. Income and Expenditure Report with Prior Year to date

Guideline for installing the Income &
Expenditure Report and Balance Sheet report
in Sage 50

Steps for installation - (This will need to be done just once. These steps may also be followed
when moving Sage 50 to a new PC and the reports were not part of the restored backup)

1. Open Sage 50 Accounts for your school.
2. Create afolder on your desktop and label it- “BOM SAGE 50 customised reports”.
3. Open aninternet browser and go to"Getting Started in Sage 50" on FSSU website.

Monthly Reports

Right click on reports and select “Save link as or “Save target as”

Note: use Google Chrome or Firefox browsers
Balance Sheet Report File
Profit & Loss Report File (budgets vs actuals) 1 year past

Guide on installing BOM reports

Guides an rmnninn BOK rennrte

Under Monthly reports, right click on Balance sheet report file and select save link as and
save to folder created in step 2

4. Right click on Profit & loss report and select save link as and save to folder created in
step 2

¢ TABLE OF CONTENTS 12
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5. The Income and Expenditure account with prior year comparatives is under Optional
Reports on this web page. Right click on the report and save link as to folder created
in step 2

Optional Reports

Income & Expenditure Report with prior ve=r tn data

Open link in new tab

Guideline for installing report o .
Cpen link in new window

Open link in incognito window

Save link as...
€ Back to Sage 50 Info page Copy link address

Inspect

1. Goto the folder on your PC created in step 2 and each report will be listed. Each
report will have to be opened and saved to My Nominal reports in the Sage 50
program.

* This PC » Desktop * BOM Sage 50 custornised reports

Mame

. BEOM-Balance-Sheet-by-no
. BOM-Profit-and-Loss-by-n
. Fixed-Income-and-Expendi

% % %

Double click on the BOM Balance sheet



FSSU SAGE Accounts Manual Section 1: Set Up

6. You may have to enter your Sage login details — manager & password

File Edit View Toolbox Sections Report Format Tools Help
Ha ¥ s 2050 %8 o0 X
A2 (None) - - B D 0 A - EEEEE
" pnmte:}\ﬁmmt ™\ DrawLine [} Draw Box | Add Image / Logo |3 Add Data Field
| {00400 10200 10300 0 40 | B0 600 |00 | (801 | 090 | 0D | o110 | 200 1 1300 | 1400 | 150 | B60 | o700 | 1180 | 190 | 2000 i1
E:
] 1. Page Header B
= Date: DATE NAME Page: PA
= Time: TIME
s NAME
s From: (CRITERIA.TRAN PERIOD_FROM To: (CRITERIA.TRAN_PERIOD_TO
= Chart of Accounts:  NAME
2. Page Header [2lv] x|
D Period Budget Difference Prior Year
3. CATEGORY Header i
D TITLE
4. CATEGORY.SORT_ORDER Header HHX
] NAME
5. Details
D ACCOU  NAME PERIOD. NOMINAL PERIOD.NOMINAL PERIOD.NOMINAL ~ PERIOD.NOMINAL P
6. CATEGORY.SORT_ORDER Footer [ El

7. The report opens then click File > click Save as
8. Thefile will save in My Nominal Reports
9. Please type in the following file name - BOM Balance sheet -click Save

10. Follow the same steps for the BOM Profit & Loss report, name the report “BOM
Income and Expenditure Account’ -click Save

11. Finally double click on Fixed Income & Expenditure Account with Prior Year to date
and then save that file naming it — Income & Expenditure Account comparative prior

year period & click save

12. Click exit - to return to Sage 50 home screen
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13. Click nominal > reports > my nominal code reports > click the star to Yellow and

they will be added to favourites

u Sage 50 Accounts Client Manager - 5t Joseph's Secondary School

Home

swnessdasibod [ €3 F E OB B M &

Mew/fedit Activity Journal Journal Prepayments Accruals Budgets  Chart of
-

File Edit View Modules Settings  Connected services Tools  Fawvourites  Weblinks Software updates Help

B (O Bor

Profit & Balance Ratio
loss sheet & Prior year

Quotatons | ©L T Allrecords (387)

entry reversal accounts  balance

,’7’ Variances

b Recent reports
4 & All reports

Balance sheet

Mame

2 Day books

My nominal code reports

Sales orders
All reports | Mominal code reports
Invoices and credits
= E i X =
= Gig & &8 2 75 Ta Ly
Purchase orders ~ -
Pl s s Expand All Collapse All Favourites
Add the documents that you use most often to Favourites to access and generate them|
Bank accounts i

clicking the staricon. You can drag and drop your favourites inte any order you want.

Fixed assets 1
Departments 4 Nominal activity " BOM Income and Expenditure Account
2 Nominal budgets
Diary 4 Nominal details 7" Income and Expenditure Account period comparatives

Income and Expenditure Account

Income and Expenditure Account

CO TABLE OF CONTENTS
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1.5 Customising School Settings and Preferences

When you open Sage 50 accounts this screen will be displayed:

‘

B Company Selection

X
o Help

Q‘ + Add Company @ Print E Export
Version ‘ VAT No. Financial year  Data path Sage Accounting migration
cA ge\Accounts\2026\Dx
CAl \Sage\Accounts\20. tice\
FSSU Master Chartof...  v32.1.349.0 2025  C:\Prog ge\Accounts\2026\Company.001 @® Not known

[J Hide company list on start-up

»

Version 32.1.349.0

| Open Company | l Cancel |

Select the required data set for your school and click OK to continue.

The Login window is presented.

Sage 50 Accounts X
© Help
Log on to Sage 50 Accounts
Username *
’ manager
Password
o-o.l ®

["] Remember my logon details

| Forgotten password

Powered by Al

Manager is the standard Logon Name & password for dataset is fssu, click Ok to open data

set.

CO TABLE OF CONTENTS
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Select Settings/Company preferences/details

1. Name - settings/company preferences. Enter your school name (enter the school roll
number at the end of your school name) and school address.

‘Company Preferences u
Accountant | Budgeting | VAT | Sage Pay ‘
Labels | Parameters | Reporting ‘
Mame | 5t Mary's College 60010F ‘
Streetl Dublin Road
Street2
Town Dublin 14
County
Post Code
Country |Ireland E LS ‘
Telephone | 012650677 \
Fax | ‘
Email | fssu@jmb.ie ‘
Website [, b ie] \
Credit Ref [ \
DUNS Number [ |
[ Lo |

¢ TABLE OF CONTENTS 7
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2. Financial Year - settings/financial year- choose the month your current financial year

starts from. The school financial year is from 1st September to the 31st August.

Financial Year >
0 Help

Enter the date in which your finandal year is to start. This
date is fixed once transactions have been posted.

Maonth September w
Year 024
oK Cancel Change...

Section 1: Set Up

Currencies % @
Number |[Name S |Exchange Rate
1 Pound Sterling GBP £ 0.000000
2 US Dollar usb $ 0.000000
3 Euro EUR € BASE
4 Argentinean Peso ARS $ 0.000000
5 Australian Dollar AUD $ 0.000000
6 Brazilian Real BRL s 0.000000
7 Canadian Dollar CAD $ 0.000000
Euro
Exchange rate: 1.000000 % | BASE Currency
Reverse: 1.000000
Currency units: euro and cents

3. Currency - settings/currency-check it is setup for the EURO

(= You can't change this at a later date, so it’s vital that you choose the right
m currency.

CO TABLE OF CONTENTS
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1.6 Setting Password and Access Rights

Password

Change Password — The default login for Sage 50 Accounts is Manager. With this login you
have access to all of the software features, therefore we strongly recommend that you create
a password for this. Create a Manager password and individual user accounts. It's important
that you make your Sage data files as secure as possible.

Select a password that is easy to recall such as the School Roll Number.

If you didn't set up a Manager password when installing the software, you can create a
password, now. To do this, open Settings » Change Password > enter the required
password into the New Password and Confirm New Password boxes » OK.

Change Password @

Logon Mame MAMNAGER

New Password [ ]
Canfirm Mew Password I:I

| Discard H oK || Cancel

Keep this password in a safe place and email it to the principal immediately.
Please give this password to the principal immediately.

(=] Remember this password as you can't open the software without it.

m Only the person logged on as Manager can create new users and modify the areas
of the software they can access.

If you have multi user version of the software you're prompted to log on. The default logon
is Manager with no password, unless you have already added a password. If you're using a
single user version, the software opens.
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Setting up Access Rights

Section 1: Set Up

From the menu bar, select Settings » Access Rights > New » enter a User Name and

Password

Define the areas a user can access

Edit user

I8

User name | Bursar

Password | |

Set Access to @

(OFull Access ()Mo Access 9 e
Description
B[] Customers Mone
M- [ ] Quotations Mone
- [ ] Sales orders Mone
&[] Invoices & credits Mone
- [m] Suppliers Partial
&[] Purchase orders Mone
- [ Preducts and services Mone
- [m] Bank accounts Partial
- [+] Nominal codes Full
B[ VAT Mone
- [+] Transactions Full
- [+] Fixed assets Full
- [v] Departments Full
&[] Projects MNone
&[] Diary Mone

- [v] Excel Integrated Reporting Full
- [w] File menu Full
... [v] Wizards Full
- [+] Settings menu Full
- [+] Tools menu Full
- [w] Help menu Full
oK | | Cancel

To define a user’s access to a module, select or clear the linext to each module as required. To
specify access within each module, click the + to show the areas within the selected modules.
You can then select or clear the tinext to each option as required.

Note:

= Only the MANAGER can change other user’s rights
= Amendments are activated the next time the user signs in to the system
= Modules and menus removed in access rights are removed from display
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1.7 Shortcut Keys

The following is a list of recommended keys that will help you use Sage 50 Accounts and enter
transactions quickly and easily:

F1

F1 will take you directly to the help files and is sensitive to the area of the program you
are working in

F2

Opens the Calculator

F3

This function key will open an item line in invoices and credits

F4

Displays the calendar, calculator or finder search list if the selected text box has any of
these special buttons attached.

F5

To activate the spell checker in a text field or the currency converter in a numeric field

F6

To copy the information from the field above

F7

Willallow you to insert a line

F8

Will allow you to delete a line

F9

Within Customer, Supplier and Bank data entry screens, this will calculate the netand
the VAT values of a transaction if the gross value is entered

¢ TABLE OF CONTENTS 21
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1.8 Backup manager

To keep your data safe, it's really important that you take regular backups of your data. As
long as you have backups, if your computer fails or your data becomes corrupt, you can easily
recover lost work and avoid hours of re-entering lost information.

Anyone can forget to take a backup, and if you're on a network it's not always easy to get
everyone to log out while you back up. With the new Sage Accounts Backup Manager,
managing your backups is simple. You can schedule backups to run automatically so you don’t
need to worry about it, and you don't need to stop processing in Sage Accounts while your
backups are running. Check data runs automatically and you can manage backups and check
data results for all companies in one place.

To open the Sage Accounts Backup Manager

1.

R

o

Open Sage Accounts »» Logon name » enter manager.
Password » enter your password for the manager logon » OK.
File » Schedule backup.

Within the Sage Accounts Backup Manager you can manage your backup schedule and

previous backup files C\SageBackups\V.32 or relevant version number

To refresh the information in the Sage Accounts Backup Manager » Refresh.
To save any changes » Save

Please back up your SAGE 50 accounts to an external device (USB Key, External hard

drive) at least once a week.

Overview

For each company, this section summarises the following information:

Users How many users are currently logged in to the company.

Check data Whether or not check data has been run. If check data has beenrun, it
shows if any errors, warnings or comments were found.

Scheduled Whether the scheduled back up and check data is currently switched on

backup status or off. You should check this area regularly. If any errors appear you should

stop processing in the relevant company and fix the errors.
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1.9 File Maintenance Problems Report

Data corruption is a serious risk to any school and any resulting data loss can be very costly.
The Check Data option checks your data files for corruption and where possible gives you the
relevant tools to fix your data.

We recommend you check your data regularly, particularly before you take a backup and after
you restore your data.

If you schedule your back up, your data is checked before the data is backed up.

An explanation of the File Maintenance Problems Report is detailed below, you can access
the report from File » Maintenance » Check Data.

Errors Indicates corruption in your data.

If you have errors we strongly recommend that you restore a backup of
the data prior to the errors occurring.

If you don't have an error free backup click the Errors tab and follow the
procedures on https://my.sage.co.uk/public/mydata.aspx to correct the
corruption on your data before you continue processing. If you continue to
process with errors your financial statements may be inaccurate.

Warnings These are issues with your data that aren’t necessarily caused by
corruption but you should still correct them. For example, aged balances
on your control accounts do not equal the balance of the outstanding
transactions.

To resolve any warnings in your data, please refer to the steps on https://
my.sage.co.uk/public/mydata.aspx

Comments Comments don't necessarily require immediate attention. However,
they do indicate minor inconsistencies in the data, which you should
investigate. For example, transactions dated beyond the current
processing date, which may indicate the transaction has been entered
incorrectly.

To resolve any comments in your data, please refer to the steps on https://
my.sage.co.uk/public/mydata.aspx

Recovery Tools | You can use this option to fix the errors, warnings and comments in the
data. However, you must ensure you use the correct options for the
relevantissue.

Full details about which options to use for your errors, warnings or
comments, can be found on https://my.sage.co.uk/public/mydata.aspx
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Settings

In this area you can set up how often you want to run a backup, what you want to include and
where the backups are saved.

Back up Choose how often you want to run the backup and check data: Back up
schedule and check data off - No scheduled backups run.

- Back up and check data once per day - Enter the time you want the
backup to run each day.

- Backup and check data more than once per day - Enter the backup
frequency and the starting time.

Company name | Selectthe companies you want the backup schedule to apply to. The
same schedule applies to all selected companies.

File types to Select the types of file you want to include in your backups. Accounts data
include in the is always included.
backup

Backup location | By default, backup files are saved to C:\SageBackups on your server
computer. If your server has alternative drives, you can choose the drive
you want to use.

Server disk New backup files are no longer created once the server’s hard drive runs
space limit out of disk space. By default, 5 GB of space is left on the server’s hard
drive. You can change this if required.
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1.10 Amend Transactions-Edit/Unallocate/Delete

Everyone can make mistakes, that's why you have the option to amend transactions after

Section 1: Set Up

you've posted them. If you make a mistake on a transaction or you enter a transaction in error,

there are two methods of amending transactions.

Amending transactions Method 1: Make corrections in activity windows

Transactions can be amended direct from the activity windows, speeding up the

corrections process and saving you valuable time.

Where to find the new options

WINDOW

Click Customers, select a customer and click Activity.

Click Suppliers, select a supplier, then click Activity.

Click Bank, select a bank account, then click Activity.

Click Nominal, select a nominal account then click Activity.

OPTIONS

« Edittransaction

+ Unallocate transaction

» Delete transaction

« Edittransaction

+ Unallocate transaction

» Delete transaction

« Edittransaction

+ Delete transaction

» Edittransaction

+ Delete transaction
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Amending Transactions Method 2
Within the Transactions module you can correct, reverse or delete your transactions.

Open the Transactions module > select the transaction you want to amend or delete H
use the following options:

If you click Edit or Delete from the Transactions window the same window appears with slight
differences.

Edit You can use this option to edit the individual item lines of a transaction.

Unallocate You can use this option to unallocate transactions. For example,
unallocating a sales invoice from a sales receipt.

Delete You can view but not change the individual item of a transaction. You only
have the option to delete the transaction.

Some of the details within a transaction are known as critical fields. If you amend a critical field
the original transaction is deleted and a new transaction is posted. Some transactions can't be
corrected or deleted and must be reversed.

Critical fields Account, Bank, Date, N/C (Nominal Code), Net, T/C (tax code) and Tax.

Note: If you post foreign currency transactions you can only amend the
Exchange rate

Non-critical Details, Department, Reference, Ex. Ref, Bank Reconciled flag, Bank Rec.
fields Date and Exchange rate.

If you amend a critical field, this:
= Raises a new deleted transaction with the original details.
= Amends the relevant information on the original transaction.

If you amend a non-critical field, the Edit option makes the changes to the original transaction
and no new transaction is created.
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The following information shows which fields can or can't be amended.

Section 1: Set Up

Account The customer or supplier account reference. If the transaction is not
associated with a customer or supplier this field doesn't appear.
From the drop-down list you can choose a different account reference.
Bank The bank account reference, this only appears on bank transactions.
From the drop-down list you can choose a different account reference.
Reference Transaction reference.
Description Description of the transaction.
Created on The date used on the transaction.
Posted on Shows the software date when the transaction was entered.
You can't edit this field.
Edited on Shows the system date when the transaction was last edited.
You can't edit this field.
Net Net value of the transaction or batch of transactions.
To amend this value, click Edit.
Tax Tax value of the transaction or batch of transactions.
To amend this value, click Edit.
Posted by The Sage user who posted the transaction.
You can't edit this field.
Edited by The Sage user who last edited the transaction.
You can't edit this field.
Bank rec on This only appears on bank transactions.
If this is selected, it also shows the date the transaction was bank
reconciled on.
Paid The amount of the transaction which is allocated and not outstanding.
You can't edit this field.
Paid in full Selected if there’s nothing outstanding on the transaction and it's fully
paid or allocated.
You can't edit this field.
Opening Selected if the transaction was entered through the OB option within a
balance record.
You can't edit this field.
Disputed Selected if the transaction has been marked as a disputed item.
You can't edit this field.
Printed Selected if you printed a cheque for this transaction.
You can't edit this field.
Item Line If the transaction is made up from multiple item lines, the individual item
Details lines appear here.
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To amend the details on an individual item line, select the line » Edit.

To save the changes » Save » Yes.

Number 2, Bank Payment X

© Help

You can change details of all grouped items at once by using the fields below, or select individual
transactions in the list to amend a specific item.

Bank Payment Details

Bank 1800 v

Reference Datapac

Description Laptops Posted by MANAGER

Created on 01/08/2025 Edited by

Posted on 04/11/2025 [JBank rec. on

Edited on / VAT Rec. Date

Net 15180.00 ¥ Paid 15180.00 ¥
Tax 0.00 =

Currency 3 Euro Foreign gross 15180.00 ¥
Exchange rate 1.000000 ¥

aptops

34410 Annual Licence 180.00 T9 0.00

15000,00 T9

To edit details of a specific item on this Bank Payment, highlight the item and click 'Edit’".

Delete a Transaction

If a transaction has been entered twice or incorrectly use the corrections options in the
Transactions module to delete it. Find the transactions you want to delete then click the delete
option on the toolbar. Confirm you want to delete the transaction by clicking Delete on the
corrections screen. The transaction is coloured red and marked as deleted in the audit trail.

HIGH RISK- Do not delete bank transactions which have been reconciled.
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1.11 Activate remote data access to be ready to
access Sage data from the cloud

Using Remote Data Access, you can share your data securely via the cloud, giving
you and other users access to your accounts from home or anywhere with an internet
connection.

Instructions

= Click on Settings > User management > Users.

= Select manager > Click Edit.

= Click Allow Remote Data Access.

= Follow the on-screen instructions and create a 15-digit passphrase when asked.
= The System will confirm that the data is now on the cloud.

= Other users including the school accountant can now be granted remote data access
subject to the user licences and using the appropriate versions of Sage.

CAUTION: Remote Data Access isn't a data backup service, and you must take regular
backups of your data.

Grant remote data access to additional users

With a one user licence - this gives 1 main user (Manager), 1 connected user and 1
Accountant user. The 1 connected user cannot access Sage at the same time as the main
user. Therefore, if two users are required at any one time, please contact Sage to avail of the
FSSU agreed price (currently €5 plus VAT) for each additional user.

Instructions

= Click on Settings > User management > Users.

= Add a user (for example for Principal) or Accountant.

= Select User type and assign appropriate level of access.

= If appropriate allow remote data access and complete the onscreen instructions

= Click Finish

= The user will now be sent an email informing them that they have been granted access.
They will need to have the relevant Sage information including the passphrase. They will

also have to activate a Sage Account with their email address and link it to the school Sage
account.
= The Accountant will be required to have Sage 50cloud Client Manager, use the same

version as the school and know their username, password, and passphrase to establish a
successful link to the schools’ data on the cloud.
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Setting up Sage 50 and using remote data access on a remote PC or
laptop
= Download the same version of Sage 50 Accounts as being currently used to the new laptop

= Have a sage account setup at www.my.sage.co.uk

= Run latest version of Sage 50, at Company setup stage, select Remote Data Access and
follow the on-screen instructions.

= The passphrase will be required to gain access.
= Login to the school accounts using username and password relevant to the user.

= Always backup as normal as Remote Data access is a data sharing system on the cloud and
is not a backup facility.

= Take note and follow up on any warnings that the PC is not connected to the drive as any
changes made while offline will mean that the processing will not update on the cloud.



Getting familiar with Sage 50 Screen layout

Menu bar

Enter Opening Balances

Setting the processing date

Entering Uncleared Bank Account Transactions
Importing Customer and Supplier Details

Entering the Budget
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To help you get used to the different options, this section explains how to navigate the
software,

The Sage 50 Accounts desktop is the main window within the software. It's the starting
point from which you can access the features you'll need to manage your accounts, so it's
really important to be familiar with how it works.

Title bar The shows the name of the Sage software you're using and the
name of the company you have open.

If more than one window is open, the title bar for the active window, the

one in which you're working, has a different colour - normally darker, to
the title bars of the other windows.

Menu bar The contains several menus, each with its own set of options.

To open amenu, click onthe menu name or press ALT + LETTER at the
same time, where LETTER is the underlined letter in the menu name.

For example, to open the Tools menu, press ALT + T. This opens the drop-
down list,

Control menu The Control menu box is in the upper-right corner of each window. They
look like this: = Tie sl
The left button minimises the window, the middle button expands the

window so that it fills the screen and the X button on the right closes the
window.

Status bar The status bar displays the Sage 50 Accounts user name, computer
name, software date, financial year start date and last transaction number.
To view or hide the status bar, go to View > Status Bar.

Navigationbar | The navigation bar, which appears on the left hand side of the desktop,

provides quick and easy access to the main areas of your software,
referred to as modules.



Work area

The main section of the software window, where information appears and
you enter data. You can choose between the following displays:
List - Shows a list of items appropriate to the selected module. A

toolbar across the top of the window displays the options available for
the module.

Throughout this help system, the step-by-step procedures assume
that you have a list window display.

Process map - Shows the workflow associated with the selected
module.

Dashboard - Shows key information for the selected module.

You can switch the process maps and dashboard view features on and off
within Tools > Options > View.

When these features are active, when you open a relevant module, the
display options appear below the module name.

File Edit View Modules Settings  Connected services Tools Favourites  WeblLinks Software updates  Help

Home
Apps and add-ons
Business dashboard

Suppliers

Bank accounts
Bank feeds

Nominal codes

Transactions
Departments

Diary

03 0 N\ S B E B B W & F F

New Edit Wizard Duplicate Activity Journal Journal Prepayments Accruals Budgets Chartof  Trial  Profit
entry reversal accounts balance  loss

[(Refresh | | [Y][ Fiter ] All records (331)

1400 Capital: Land and Buildings Cost B/Fwd

1401 Capital:Land & Buildings Additions

1402 Capital: Land & Buildings Disposals

1410 Accumulated Depreciation: Land and Buildings B/BFwd

1411 Deprediation: Land & Buildings Current Year

1412 Deprediation: Land & Buildings on Disposal

1420 Capital: Fixtures, Fittings and Equipment

1421 Capital: Fixtures, fittings & Equipment Additions

1422 Capital: Fixtures,Fittings & Equipment Disposals

1425 Capital: Covid Minor Works F,F & EB/BFwd

1426 Capital: Covid Minor Works Fixtures, Fittings & Equipment Add

1427 Capital: Covid Minor Works F,F& Equipment Disposals

1430 Accumulated Depreciation: Fixtures, Fittings and Equip B/BFw

1431 Depredation: Fixtures,Fittings & Equipment Current Year

1432 Deprediation: Fixtures,Fittings & Equip Disposals

1435 Acc Dep: Covid Minor Works Fix, Fit, & Equip B/Fwd
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Located at the top of the desktop, the menu bar contains various options that control a
number of software functions.

File

Edit View Modules Settings  Connected services Tools Favourites  WeblLinks Software updates  Help

Some examples of key school processes which you can access via the menu bar are:

File

File

File

File

File

Back up

Schedule back up

Restore

Maintenance > Check Data

Microsoft Integration

Settings > Company Preferences

Settings > Change Program Date

Tools > Options > View

Tools > Internet options

Tools Period End > Year End

Help > Contents and Index

Help > Shortcut Keys

You can use this to make a secure copy of your data
files.

Use this feature to schedule regular automatic
backups of your data.

You can use this to restore a copy of your data files,
returning them to a state before the backup was
created.

You can use this to check that your data is free
from corruption. We recommend that you run this
whenever you use the software.

You can use this to link Sage 50 Accounts to the
Microsoft Office suite.

Contains all of your company details including the
address and VAT information.

Set your defaults for all transactions and invoices you
enter in Sage 50 Accounts.

Customise your software in terms of the default
desktop and ledger views.

Enter your automatic update settings and online
account information.

Use this option to run your year end routine at the
close of your financial year.

Comprehensive software help files. You can also
access these at any time by pressing F1 on your
keyboard.

Details of how to navigate quickly and efficiently
using the keyboard.



When you start using Sage 50 Accounts you will need to enter a trial balance to represent
your financial position. Preparing for this routine is vital. The accuracy with which entries are
posted is imperative to ensure success.

1. Decide on the date you are going to start using SAGE 50.

2. Print the Trial balance for the current year including opening balances from TAS (or
relevant prior accounting system) e.g.TAS 134 report.

3. Check the account codes on TAS (or relevant prior accounting system) Trial Balance to
the FSSU Standard Chart of Accounts. Change the codes on the Trail Balance where
necessary.

4. If you use additional nominal codes to the standard FSSU chart of accounts you will need
to create these codes. See section on creating nominal codes. Only setup New Nominal
codes which are absolutely essential for your school’s accounts. New Bank Account
Codes must be setup using the BANK Module in SAGE.

5. The Opening Balances Wizard guides you through the process.

6. To open the wizard go to > Tools > Opening Balances. Select ‘enter the trial balance
from your accountant’

Opening Balances ﬁ

The following series of actions will guide you through all of the necessary steps to ensure that
your Opening Balances are entered correctly. Ensure each step is ticked after you complete it

Enter a default date for your opening balances 9

Enter opening balances for your customers 0

Enter opening balances for your suppliers e

Check the customer and supplier opening balances e

Reverse the nominal balances in preparation for entering the trial balance 9

Enter the trial balance from your accountant 0

& 55 e 1

Enter the undleared transactions for your bank account(s) e

Check opening balances against the trial balance from your accountant e

Check your data e

B e OE E B OE B O &

Backup your data 9

L
i

{tﬁ@!n

{

Close
a

7. You must enter the complete Trial Balance before saving.

8. Enter the figure from the TAS (or relevant prior accounting system) Trial Balance using the
last day of the period e.g. If the TAS 134 report was ran for period 1 to 10 (September to
June) use the 30th of June XXXX as the date of input.

9. Save the Trial Balance.

10. Printatrial balance and agree to the TAS (or relevant prior accounting system) trial balance
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Section 2: Opening Balances

11. Tools > opening balances > Check opening balances against the trial balance from your
accountant.

12.

Criteria for Period Trial Balance X

Criteria Values

Enter the values to use for the criteria in this report

Period [Fotncusve) <] [12 Avgustzozs R
Preview a sample report for a specifi of records or (0 for all) 0 3
L s (& ] se |

Enter date of trial balance as final period used in TAS 134report (or relevant accounts
system TB report) e.g. June XXXX

Check the opening balances against the TAS (or relevant prior accounting system)
trial balance and investigate any differences

Check Data

Run the ‘check data’ wizard to ensure all data entered correctly

Awarning is displayed if there are any discrepancies and these must be corrected
before continuing.

Back up

Take a backup of your data using the wizard. See Back up Manager.

To backup go to File > Backup. You will be prompted to check your data. It is best
practice to check your data at this point. If the check returns any errors you should
contact the FSSU for assistance. After closing the check data routine you will be
presented with the backup window.

Back up |il

Company details

Advanced options

Pratiois: hackips You are about to create a backup oft

Company name: FSSU SAGE 50

Foundin: C:\PROGRAMDATA\SAGE\ACCOUNTS20 16\COMPANY 009\

Where do you want the company backed up to?

To select a location to save this backup to, dick Browse. We have suggested a
filename for this backup. If you are happy with this suggestion, dlick OK.

Backing up to removable media? Insert the device before dicking OK.

The Backup manager can back up your data automatically. For more information,
press F1.

Fl\ename‘:‘ SageAccts FSSU SAGE 50 2016-06-02 12-05-28.001 |

Location™: | C:\SageBackups\v22\FssU 03032015 |

Browse...

‘ OK || Cancel || Help |

From here you can choose your filename and backup location. Click OK to backup.
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2.4 Setting the processing date

When you're processing in Sage 50 Accounts the date you use on every transaction is of

Section 2: Opening Balances

critical importance to the accuracy of your data. By default, Sage 50 Accounts uses the date

from Windows as its default date, that is, today’s date.

If you want to change the default processing date, you can do this in:

Settings > Change Program Date

Change Program Date

This date can be changed at time of posting.

Default Program Date ~ ERYBSUFATPE

Enter a new date to be used as the default for transactions.

OK

Cancel
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The accountants year end adjustments to the bank accounts must be completed before
running the report. The TAS (or relevant prior accounting system) unreconciled report

matching the closing bank reconciliation summary for the period is required. The

unreconciled transaction will need to be entered separately.

1. To enter the outstanging transaction on the bank account select the Opening Balances

Wizard.
2. To open the wizard > Tools > Opening Balances.
3. Select ‘enter the uncleared transaction from your bank account(s)’

4, Follow the wizard and enter the transactions.

Bank Opening Balances

Bank AC*

|Name |Department™ [Type
1300 Current Account 31/10/2016 | O/Bal 0 Receipt
1300 Current Account 31/10/2016 | 235556 0 Payment
1800 Current Account 31102016 | 235580 ] Payment

|Amount*®  |TjC*
5000.00 T8

2000.00 T2
500.00|T9

Save

| | Cancel

5. Print the unreconciled report and agree to the Bank Reconciliation report(s)

Bank Accounts > Reports

Check Data

Run the ‘check data’ wizard to ensure all data entered correctly.

Unreconciled Bank Transactions

A warning is displayed if there are any discrepancies and these must be corrected before

continuing.

Back up




Take a backup of your data using the wizard. See Back up Manager.

To backup go to File

Backup. You will be prompted to check your data. It is best practice to

check your data at this point. If the check returns any errors you should contact the FSSU for
assistance. After closing the check data routine you will be presented with the backup

window.

Back up

Back up company

Advanced options

Previous backups

oSS

Company details
You are about to create a backup of:

Company name: F55U Master

Foundin: C:\PROGRAMDATA\SAGE\ACCOUNTSY2016\COMPANY.001}

Where do you want the company backed up to?

To select a location to save this backup to, dick Browse. We have suggested a
filename for this backup. If you are happy with this suggestion, dick OK.

Backing up to removable media? Insert the device before dicking OK.

The Backup manager can back up your data automatically. For more information,
press F1.

Filename=:| SageAccts FSSU Master 2016-05-04 16-18-59.001 |

Location™: | C:\SageBadkups\w22\FSSU Master |

Browse...

| 0K || Cancel || Help |

From here you can choose your filename and backup location. Click OK to backup.



The Data Import wizard can enable you to quickly import information from TAS (or relevant
prior accounting system) to Sage. The import routine allows for the creation of new records or
updating specific parts of existing records leaving the rest of the data unchanged.

To import the names and addresses etc of the TAS (or relevant prior accounting system)
suppliers run the report in TAS (or relevant prior accounting system) and export to excel.

Use the template for suppliers and copy the information into the correct columns. Remenber
there must be no text or blank rows. The account codes must be less than 8 characters.

Once you have compleded the template save it to your desktop.

To import the template select File > Import

1. The data import wizard appears recommending that you perform a Backup before

proceeding.
F = Bl
Data Import &J
Data Import
i Welcome Welcome 9
‘fou can import data from Excel worksheets (*.xls; . xlsx) and files containing 9
Data Type comma-separated values (*.csv).

To help you import your data, templates with the correct import structure are
Data Source available here,

° Field Mappings

Import

WARNING: The Data Import procedure is NOT reversible.

Itis strongly recommended that you backup your current company Backup
data before proceeding.
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2. Click next and select the data type from the list > Supplier Records

Data Import u

o Welcome Data Type™ e

Select the type of data you want to import: 9

y3 Data Type Audit Trail transactions
Customer records
Fixed Asset records

e Data Source MNominal accounts
Product records

Field Mappi Project records
teld Mappings Project-Only transactions
Stock take

° Import Stock transactions

3. Select the format type and Browse your desktop for the template prepared earlier.

Data Import g

Data Import

:
o P L | Data Source e

Select the format of the data you will be importing:
o Data Type () Comma-separated (*.csv)

(®)Excel worksheet (=.xs; *.xlsx)
3 Data Source

Select the file to impart™:
o Field Mappings | C:\5t Marys 65130E\Copy of Supplier Record FULL template,xls

° T [¥IFirst row contains headings @)

| | Browse...
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4. The field mapping screen appears and if using the Sage template liittle or no mapping will
be required.

r Data Import ﬁw

Data Import

o Welcome Field Mappings 9

Map the fields in your data to the fields in Sage 50 Accounts.

o Data Type 1 d Field

o Data Source coount Reference
Account Mame Account Name

E 3 Ficld Mappings Street 1 Steeil

Street 2 Street 2

e Import
Town Town
County County
Postcode Postcode

Map file in use: [none]

Clear Map | | Load Map... | | Save Map... |

T

5. Theimport window appears summarising the options chosen. To proceed click Import

i Data Import ﬁ1

Data Import

° Welcome Import 9

‘You are now ready to import your data.
o Bk e The following is a summary of the options you have chosen. If you need to change any
of them, dick the Back button now.
o Data Source Data type: .
Supplier records
° Field Mappings Data source:
Copy of Supplier Record FULL template. xls
=}y Import Sheet:
Supplier Record Template

m

Header row:
Yes

To begin importing your data, dick Import.

.
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6. The import results window appears showing all records imported/not imported.

importRenits e ——

r is Imported

ADT001, ADT Fire & Security Ltd
ADV001, Advanced Learning |j|
ALL0O1, Allianz Insurance

ALLWO1, Allwin

ALUD1, Barbara Aluk

AMAZ0D1, Amazing Brains

ASHO02, Ashvile Media Group Ltd

ATL0O01, Atlantic Fire

AURD02, Aurivo tfa Connacht Gold Retail Stores
BO1, Bord GAis

BALLOO1, Ballisodare Pharmacy

- Records not Imported

| Print | | Save Errors... | | Edit Import | | Help |

7. If the import fails, correct the area of the spreadsheet listed in the error message and
complete the import process again.
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Before entering the creditor’s details it is important that any adjustments made by the accountants at the
year end are reflected in the creditor’s balances. A detailed aged creditors report will be used to enter the
balances. Itis very important to check that the total on the creditors list agrees with the creditors total on

the trial balance.

Opening Balances Wizard guides you through the process.
= To open the wizard go to > Tools > Opening Balances.

= Select ‘enter opening balances for your suppliers’/Customers

r
Opening Balances

The following series of actions will quide you through all of the necessary steps to ensure that
your Opening Balances are entered correctly. Ensure each step is ticked after you complete it.

Enter a default date for your opening balances e

Enter opening balances for your customers 9

Enter opening balances for your suppliers g

Check the customer and supplier opening balances e

Rewverse the nominal balances in preparation for entering the trial balance a

Enter the trial balance from your accountant e

) Gl | 5| E5

Enter the undeared transactions for your bank account(s) e

Check opening balances against the trial balance from your accountant e
F.1
g Check your data e
=
E Backup your data a

DDDDDDDDDD@E

Cloze

v

— .
Supplier Opening Balances

==

|Name

Balance |m

|Ex. Ref |Department®  [Type
OfBal 1]
OfBal 0

ADTOO1

ADT Fire & Security Ltd

31/10/2016
31/10/2016

Invoice
ALLOD1

Allianz Insurance Invoice

When the balance are input run Tools
and supplier opening balances’.

When the balances agree run Tools
balances in preparation for entering the trial balance’.

Enter the total of the creditors as a debit entry.

100.00
5000.00

Opening Balances and select ‘Check the customer

Opening Balances and select ‘reverse the nominal



1. The budget must be entered in Sage 50 once the software is rolled over to the new
Financial Year.

To help you input the school budget to Sage 50, we have included in the Budget Template a
sheet called “Sage 50 Import” which provides a summary of the nominal codes and the total
budget figures for the year.

File Home Insert Pagelayout Formulas Data Review View Automate Sage 50 Accounts Help Sage

rn A av | =
| 4 cut Calibri vin AN | == E v | BwapText General v @ % @ % E)} ﬁ
—— [Bcopy ~ -
Paste B = o= Conditional Formatas Cell Insert Delete Forl
; I U~ HEY & A = Merge & Center ~ | @F v @ 98
v <% Format Painter = = - = R L] B % 9| W 48 Formatting v Table ¥ Styles v v -
Clipboard 5] Font 5] Alignment N~ Number ~ Styles Cells
H6 - S =F6=G6
A B | c D E F G H
1| Voluntary Secondary School Formula Check
2 | NON_DEIS School Budget 2023/24 The total of figures in the import sheet should add up to the income
z SAGE 50 Budget Import Figures [A formula check has been added to confirm this, if there is a descre
4 | 1.The nominal code detail here should be the same as in your Sage 50. If you added additional codes to your
5 |1 & Exp budget please add the codes and values into the budget below. Do not leave any blank lines Total Per Import Sheet  Per Budget sheet Check
6 |2. Ensure the figures are the same in column € and D for each nominal code 487530 487530] TRUE |
7 |3. The detail in Column A, B & D must be then copied into a Sage 50 Budget Import template for ir ing into Sage 50 Note this is not the surplus
8 Click here for full instructions for importing budget figures into Sage 50.
9 A B C D
10 Refn  [Name Yearly Month 1 Budget
11 Copy |Copy into Import Template Do not use | Copy & paste as values into Import Template Subtotal per Import sheet Subtotal per Budget she¢Chack
12 3010 _|[capitation 178224}
13| 3050 _[School Support Services Grant 126618
14| 3100 _|[Secretarial Grant 23275)
15| 3130 _|Caretaker Grant 19075}
16| 3140 _|Special Education Equipment Grant 0
17 | 3150 _[BookGrant Income 13536
18 3155 _|School Library Books Capital Grant 0
19| 3170 _[Special Subjects Grant 0
20| 3171 _|irish and Bilingual School Grant 62322
21| 3190 _|icse Grant 600}
22| 3200 _|Transition Year Grant 1520
23| 3210 _|Leaving Cert Applied Grant 3473
24| 3220 | Grant for Traveller Students 1068)
25| 3230 _|ICT Grant Non Capital 0
26| 3240 |Supervision and Grant 20874
27 | 3245 _|Physics/Chemistry Grant 2g]
26| 3255 _|State Exam Income 0
29| 3260 _|school Excellence Fund Income. 0
30| 3275 _|Minor Works Grant-Non Capital 0
31 3276 _|Temporary Grant Income 0
] .| 3.Income & Expenditure Budget | 4.Opening Bank Position | 5.Estimated Bank Cashflow | 6.Capital Budget | 7. Monthly Cashflow 8. Sage 50 Import

Readv._ % Accessibility: Investioate

The details in Column A, B & D of this sheet can be copied into a template available in Sage
50, and this will enable the budget data to be imported into Sage 50.

Previously these figures would have been filled in manually into a Sage Budget Import
Template.
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The following Steps 2 — 4 outline this process.

Section 2: Opening Balances

2. Open Sage 50 to download and complete the Sage nominal data import template.

data before proceeding.

Data Import *
Data Import
il Welcome Welcome 9
| You can import data from Excel worksheets {%,xls;*.xlsx) and files containing o
o Data Type | comma-separated values (%.csv).
To help you import your data, templates with the correctimport structure are
o Data Source available jere,

| WARNING: The Data Import procedure is NOT reversible,

It is strongly recommended that you badkup your current company

[ cof |

! 4

Click here to open the template that will help import the budget data.

| | = | Import Templates

Home Share View

W Copy path

Name
s Quick access

B Desitop - Customer Record FULL template
‘ Pownlgads * @ Fixed Asset Record FULL template
Documents * @ Nominal Record FULL template
[&] Pictures * @.Prod.ﬁ.ct‘ﬂeco;d FULL temblaté

. budget Project Record FULL template

' budget import tem; @ Project Transaction FULL template
[7] final presentation d @ Stock Take FULL template
@ Stock Transactions FULL template

. Import Templates ]
— Supplier Record FULL template

@ OneDrive - JMB
[ This PC

¥ Network

< D o Cut « Moveto~ X Delete ~

Select no
ag
to Quick Co Paste _ - New Properties
IR By [7] Paste shortcut B copyto =] Rename folder B o History 5 Invert sele
Clipboard Organize New Open Select
4 | « Sage » Accounts > Import Templates v O 0O Search Import Tem
Date modified

@ Audit Trail Transaction FULL template

Liiohd i3l open - [ selectan
- [t Edit i)

04/06/2021 16:24
04/06/2021 16:24
15/12/2020 13:37
15/12/2020 13:37
15/12/2020 13:37
15/12/2020 13:37
15/12/2020 13:37
15/12/2020 13:37
15/12/202013:37
04/06/2021 16:24

Nominal Record
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File Home Insert Pagelsyout Formulas Data Review View Automate Sage 50 Accounts Help  Sage

< U - o

LD [)I;(u( Calibri <11 A L 2% wrap Text General i m Eﬁ @ @ E B
Copy ~ -

Paste A~ - = === - : - Conditional Format as  Cell Insert Delete Forf

S 8 Format ot || > A B -4 = = == B MegeaConter W% 9 4R Formatting v Table ¥ Styles ~ ~ ~
Chpboard [ Foat (] Agnmere 5 Number 5 Styles Celts

H6 - S =F6=GH

4 A 8 c 2] E F G H

1 Voluntary Secondary School Formula Check

2 NON_DEIS School Budget 2023/24 The total of figures in the import sheet should add up 1o the income

3 SAGE Sonu&llmmﬂem A formuda check has been added to confirm this, If there is a descre

4 1.The nominal code detoil here should be the same as in your Soge 50. If you added additional codes to your

518 budget piease odd the codes and values into the budget below. Do not leave any blank lines [Total Per Import Sheet  Per Budget sheet Check

& |2. Ensure the are the same in column € and D for each nominal code 487530 u7s

7 3. The detail in Column A, B & D must be then intoa 50 B 1 into 50 Note thes is ot the surplus

8 Click here for full ingtructions fo importing budget figures into Sage SO.

s A 8 C D

10 Refn  |Name Yearly Month 1 Budget

uiogLﬁ!lmome&te Do not use | Copy & paste as values into Import Template Subtotal per Import sheet Subtotal per Budget she:Check

12| 3010 [Capeation 178224)

13 3050 Jschool Support Services Grant
14| 30
15| 3130 |caretaker Grant

16| 3180 |special Education Equipment Grant
17| 3150 |eockGrant income

18| 3155 |school Ubrary Books Capital Grant
19| 3170 |special subjects Grant

20| 3171 |insh and Bngual School Grant

21 1CSP Grant
22 Transtion Year Grant

23 Leaving Cert Apphed Grant

24| 3 (Grant for Traveler Stadents mtj
25| 3| ICT Grant Noa Capital

26| 3. Supervision and Substitution Grast 2087:
27 3 Physics/Chemistry Grant

28| 3 State Exam income

29| 3 School Excellence Fund income

30 32 [Minor Works Grant Non Capital

31| 32 |Temporary Accommodation Grast income

“ ... 3.Income & Expenditure Budget | 4.Opening Bank Position | 5. Estimated Bank Cashfiow | 6. CJW‘“W 8. Sage 50 Import

Roacky ; Accessitbty, ineestioate

3. Check the accuracy of the information in sheet 8 and then Copy relevant information
from the VSS Budget to the Sage Nominal record template.

Open the VSS Budget Template 2025/2026

1. Check that the nominal codes & names agree with the codes that are already in Sage 50.
This template will over-write the nominal code detail that is already in Sage 50

2. Check the formulas are populating correctly from the “Income & Expenditure Budget
Sheet”. The total of figures in the import sheet should add up to the income plus the
expenditure less the contingency in the budget, the check box below will turn red if there

are any errors.

Formula Check
The total of figures in the import sheet should add up to the incoglfe plus the expenditure less the contignecy in the budget
A formula check has been added to confirm this, if there is a repancy with any section of the budget the check box will turn red

Total Per Import Sheet Per Budget sheet Check
487530 487530 TRUE

Note this is not the surplus

3. Below are the steps required to copy the information from the Sage 50 import sheet to
the Sage nominal record full template. One column at a time is copied, as follows:
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3.1 To copy the information in column A ‘Refn’ from the VSS Budget Template - Highlight
A15:A212 (i.e. all the nominal codes), right click and copy.

In the Sage Nominal record FULL template Click into A2 right click and paste

Bl AutoSave @ ori} = Mominal Record FULL template - Read-Only - Compatibility Mode -

Infert  Page Layout Formulas Data  Review View  Help

7 fut Calibri Y AN === B 28 Wrap Text
[E copy . B I U~ O~ ﬁ e E] = = = Merge & Center ~
< Format Painter
Undo Clipboard ] Font ] Alignment
BS J&| secretarial Grant
B 5 D E

gt MName Yearly Budget 9 Manth 1 Budget YMonth 2 Eugget h Mol
¥ 3010 Capitation 178224

3 3020 Enhanced Capitation (DEIS) 0

4 3050 Support Services Grant 126618

5 3100 Secretarial Grant 23275

6 3130 Caretaker Grant 13075

3 3140 Special Education Equipment Grant 0

8 3150 Book Grant Income 13536

5 3160 Book Rental Scheme Grant 0

10 3170 Special Subjects Grant i}

11 3190 JCSP Grant 0

12 3200 Transition Year Grant 1520

13 3210 Leaving Cert Applied Grant 3473

14 3220 Grant for Traveller Students o

3.2 To copy the information in column B “Name” from the Budget Template
Highlight B15:B212 (i.e. all the names), right click and copy

In the Sage Nominal record FULL template, Click into B2 right click and paste.

3.3 To copy the information in column D ‘month 1 budget’ which contains the total budget
figures from the Budget template -

Highlight D15:D212 (i.e. all the values). right click and copy.

Then in the Sage Nominal record template Click into D2 (Month 1 Budget) right click and
paste as values.

.-:.D Paste Options:
o

o . o
O b LA Lp ¥ Lo

Save the file with a revised name that specifies the year the budget template relates to.

Retain this file and once year end is run in Sage 50 for Aug 2024 then follow steps 5 - 7.



A B £ D E 15
[ 1] Name Yearly Budget Manth 1 EJ_L_J_C_ig_e:f IManth 2 Budget {Month 3 Bud
2 | 3010 Capitation 178224
3 | 3020 Enhanced Capitation (DEIS) 1]
4 3050 Support Services Grant 126618
5 | 3100 Secretarial Grant 23275
6 | 3130 Caretaker Grant 19075
Tl 3140 Special Education Equipment Grant 1]
g 3150 Book Grant Income 13536
9 3160 Book Rental Scheme Grant 0
10 | 3170 Special Subjects Grant 1]
11 3190 JCSP Grant 0
12 | 3200 Transition Year Grant 1520
13 3210 Leaving Cert Applied Grant 3473

4. Backup datain Sage 50 before importing Sage Budget template figures.

Note the year end must be run in Sage 50 for Year end Aug 202? before importing the

budget for the new Financial Year.

Data Import

Data Import

1

o Data Type

Welcome Welcome

To help you import your data, templates with the correct import structure are

o Data Source available Jere,
° Field Mappings
o Import

WARNING: The Data Import procedure is NOT reversible,

Itis strongly recommended that you backup your current company

data before proceeding.

‘fou can import data from Excel worksheets (*.xds;*.xlsx) and files containing o
comma-separated values (*.cav).

Cancel

5. In Sage 50 select File>Import.

Take a Backup.

Then click next.

>Data Type = Nominal accounts
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Data Import

Data Import

o Welcome

2 Data Type
e Data Source
o Field Mappings
e Import

Data Type*

Select the type of data you want to import: (7]

Audit Trail transactions

Badk | | Mext

Select Nominal Accounts and Click Next.

Data Import

Data Source

Select the format of the data you will be importing:
(D) comma-separated (*.csv)
(®Excel warkshest (*.xls; = xdsx)

Select the file to import™:
1 o Field Mappings | || Browse...
o Trab [¥IFirst row contains headings 0
[ [

Browse for the relevant Sage Budget Import template & Click Next.
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Data Import | 29 |

Data Import

o Welcome Field Mappings 9

Map the fields in your data to the fields in Sage 50 Accounts.

o Data Type Required  |Imperted Field Sage Field
e Data Source = _REﬁ-' fREfn
MName MName
LW Field Mappings .Yearly Budget .\’early Budget
|Month 1 Budget |Month 1 Budget
e Import 1 I
Menth 2 Budget Meonth 2 Budget
.Monﬁ'l 3 Budget .Momh 3 Budget
.I\"ionﬁﬂ 4 Budget :Mﬁnﬁ 4 Budget

Map file in use: [none]

Clear Map || Load Map. .. | | Save Map... |

o [ v ]

Click Next.

Data Import X

Data Import

Welcome Import e

‘You are now ready to import your data.

DatTyps The following is @ summary of the options you have chosen. If you need to change any
of them, dick the Back button now.
Data Source Data type: L]

Nominal accounts

Field Mappings Data source:
Copy of Nominal Record FULL template sage 50 test. xls

Tanport Sheet:
MNominal Record Template

Header row:
Yes

To begin importing your data, dick Import.

-

Click Import.
6. Runthe BOM Income & Expenditure report to verify the budget figures.

The Budget figures can be edited in Sage 50 in the nominal code section, double click on
the relevant code and amend the figure under the budget heading in month 1.
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The Bank Accounts window

Creating New Bank Account

Setting the processing date

Bank Payments
Inter-Bank Transfer
Bank Receipts
Recurring Bank Entries
Bank Reconciliation
Bank Reports

To Cancel Old Cheques

Introduction to Bank Feeds
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3.1 The Bank Accounts window

To help you to manage and maintain your cash flow, this window gives you quick and easy
access to all of the bank options.

BN 2 & R &8 5 § w (B &A@ E
New Edit Wizard Duplicate Activity Reconcle Bank  Supplier Batchsupplier Bank  Customer Remittances Customer Bank Supplier Recurring
transfer payment  payment payment refund receipt receipt refund items
New/edit From the drop-down list you can choose:
New - To create a new bank record.
Edit - To edit an existing record
Wizard - To be guided through creating a record.
Duplicate - To create a new account based on the details of an existing,
selected record.
Activity Opens the activity window for any selected account. This window shows a
list of the transactions for the account.
Reconcile Match the activity on your bank account record to those on your bank
statement. You can match transactions manually or by using E-reconcile.
Bank transfer Record the movement of money between your bank accounts.
Payments Those payment types are options across
Supplier payment - To pay an individual supplier.
Batch supplier payment - To pay multiple invoices.
Bank payment - To record bank payments for transactions not
associated with a customer or supplier. For example, petrol costs or
bank charges.
Customer refund - To process a refund for a customer.
Remittances - To print a remittance advice if required.
E-payments - To record payments if you pay your suppliers
electronically.
Customer Record customer receipts to clear outstanding invoices.
Receipt
Bank receipt Record bank receipts for transactions not associated with a customer or
supplier. For example, interest or grant money.
Supplier refund | Use this option to record any refund received from your suppliers.
Recurring Items | Set up transactions that are made on a regular basis such as direct debits
and standing orders.
Cash register Use this option to record cash till takings.
Deposit cash When you deposit cash takings at the bank, you can record it here.
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Cash Flow Manage your cash by forecasting the money you expect to pay in and out
of the business.

Delete You can use this option to delete a bank account.

Clear You can use this option to clear any account selections.

Print List Use this option to print a list of your accounts and balances.

Send to Excel

You can use this option to export a list of your accounts and balances to
Excel,

Statement

Generate statements for each bank account.

Reports

Access bank reports using the Report Browser.

If any of the headings are missing, right click and ensure that the required option is ticked. Or if

you wanted to remove some options, untick as appropriate.

B =B T

Btatements Cheques Reports Show me

New

Duplicate

— Edit
Wizard in

[
Q

Recondile

Bank transfer
Supplier payment
Batch supplier payment
Bank payment
Customer refund
Remittances
Customer receipt
Bank receipt
Supplier refund
Recurring items
Cash register
Deposit cash
Cash flow
Download receipts
Delete

Clear

Print list
Send to Excel
Statements
Cheques
Reports

Show me how

Use Defaults
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3.2 Creating New Bank Account

The nominal accounts you want to use for bank transactions are created from the Bank
Accounts module and not the Nominal codes module.

This guides you through the set up and helps to ensure you don't miss any key information.

You can access the New Bank wizard in Bank accounts » Wizard.

i Account Name

o Account Details
o Bank Details

° Contact Details
o Opening Balance

fiad —— —

Bank Information

Account Name 9

To create a new bank account you need to enter the bank account name and a unique
reference.

The next available account code in sequence has been entered for you. You can keep
this reference or enter your own instead.

‘You can assign an account type to your new bank account . You can also choose
whether or not you want to reconcile this account in the future.,

Account type |Cheque Account w

[[IMo bank recondiiation

Cancel

Name The description that appears in the Bank Accounts window to help you to
identify the account, for example Bank Current Account.
You can enter up to 60 characters.

Ref A unique reference thatidentifies the bank account in your Chart of
Accounts (COA). You can't change this.
The code must have a least four digits and no more than eight, between
0001 and 99999999.

Account type From the drop-down list you can choose one of the following:
- Cheque Account
- Cash Account
- Credit Card Account
Once you enter transactions into the account, you can't change its type.
Each account type generates its own transaction types. For example,
payments can be bank payment (BP), cash payment (CP) or visa payment
(VP), depending on whether the account type is a cheque account, a cash
accountor a credit card account.

No Bank If you don't want to reconcile this bank account, select this check box.

Reconciliation
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Account Details

Account No.

You can enter up to 60 characters for the bank account number.

Account name

The name of the account.

Minimum limit

The amount that you don't want the balance of this account to drop below.
If the amount of money you have in this account goes below this amount
the bank appears in red in your Bank Accounts window.

Sort code The bank sort code.

Expiry If this account is for your company credit card, enter the expiry date of the
card.

Currency The currency of the bank account. This defaults to the base currency.

BACS/SEPA If you use Bank Automated Clearing System (BACS) to make payments

Ref. using e-Banking, enter your reference number. The reference identifies
the payer and is included in the payment files.

IBAN Enter the International Bank Account Number (IBAN). This is a specific
format of the bank account number that makes transactions between
European countries easier by reducing errors and delays. An IBAN is
always used in conjunction with a Bank Identifier Code (BIC).

BIC/Swift Enter the BIC number or Swift Code for this bank account. The BIC or

Swift Code, is a way of identifying financial organisations.

If this is your default company bank account, this information appears
under your company name and address on any invoices and orders you
print.

Additional Ref.

Any additional information you have relating to your bank account.

You can enter any text, up to three lines of 60 characters.

Bank Details

Bank name

The name of your bank, which can be up to 60 characters.

Address lines

You can enter each line of your bank’s address here, up to 60 characters
perline.

Contact Details

Email The email address for your bank.

Website The bank’s website address.

Contact Name The contact for your bank account, up to 30 characters.
Telephone The telephone number for your bank, up to 30 characters.
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3.3 Setting the processing date

When you're processing in Sage 50 Accounts the date you use on every transaction is of critical
importance to the accuracy of your data. By default, Sage 50 Accounts uses the date from Windows as its
default date, that is, today’s date.

If you want to change the default processing date, you can do this in

Settings » Change Program Date.

Change Program Date X

Enter a new date to be used as the default for transactions.
This date can be changed at time of posting.

Default Program Date ~ ERYBSUFATPE

OK Cancel
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3.4 Bank Payments

Introduction

Bank payments are a quick and easy way to record cheque payments, electronic payments or
payments which aren’t for a supplier, such as bank charges or loan repayments.

When you post a Bank payment the transaction type changes depending on the bank account
type in the bank record. The payments appear on the audit trail as the following transaction
types:

= BP = Payments from a bank account.

= CP = Payments from a cash account.

= VP = Payments from a credit card account.

To post a bank payment

N.B. Check the program date —change date

Ensure you are in the Bank Accounts module and click Bank Payment. Schools using the
suppliers ledger will post supplier payments in the supplier module.

1. Bankaccounts » Bank payment > complete the window as follows:

Bank* From the drop-down list, choose the bank account you want to pay
from.

Date* Enter the date of the payment.

Ref Enter the reference you want to associate with the payment.

N/C* From the drop-down list, choose the required nominal code.

Details Enter the details for the payment.

T/C* From the drop-down list, choose the required tax code.

2. Save » Close.

.. Tip:

"‘ 3. Ifrequired, you can enter more than one payment ata time.

= 4. Use F6 to copy the previous column entry and Shift F6 to increase by 1
the previous column entry.

Any payment can be posted to a number of nominal codes for analysis purposes. Only one
line will appear in Bank Activity this is because the same date and reference number was
used when entering the transactions. The activity split can be seen by pressing the Show
Details button. This can be changed from Settings » Bank Defaults, by unticking Group Bank
Transactions.
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Q Bank Payments

= = = = = -

L = =T KD ] |
Clear Print Insert Remove Copycell Copycellabove Calculate Memorise Recall Printlist Send to
form Cheque row (F7) row (F8) above (F6) +1 (Shift +F6) net (F9) Excel
Bank

I Current Account 1 ] Tax Rate
NjC gfﬁoe Equipment (Non Capital)

|Attach

|Date®

X

([~}
B

1800 ©  29/09/2025 123 | 6300 0 0.00 300.00
1800 [+ |29/09/2025 123 ‘ 6350 0 Biz equip - Off.... 500.00 T9 ‘ 0.00 500.00 |
|
[
'\
|
[
\ \ \
| [ |
| | |
| | |
[ 800.00 | \ 0.00]| 800.00 |

Itis very important to add in as much detail of the payment as possible for nominal activity
review purposes.
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3.5 Inter-Bank Transfer

The bank transfer option exists solely to move money between the bank accounts. This
routine is accessed from Bank accounts then Bank transfer

1. Bankaccounts »» Bank transfer.

2. Complete the Bank transfer window as follows:

From* From the drop-down list, choose the bank account you want to
transfer the money from.

To* From the drop-down list, choose the bank account you want to
transfer the money to.

Payment Amount of the transfer.
Amount

Date* Date of the transfer.
Reference Reference for the transfer.
Description Details of the transfer.

- Tip:
—,. If required, you can enter more than one payment at a time.

3. Save » Close.

E.L: Bank Transfer = (m] X

flear Insert Remove Copycell Copy cellabove Memorise Recall
brm  row (F7) row (F8) above (F6) +1 (Shift +F6)

Send to
Excel

L2 E % % BB

1800 1850 01/08/2025 TRANS Bank Transfer 0 200.00
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3.6 Bank Receipts

Bank receipts are a quick and easy way to record one off receipts or receipts, such as grants,
school generated income, voluntary contributions, interest, dividends received, money
received for an insurance claim and other income.

When you post a bank receipt the transaction type changes depending on the bank account type
in the bank record. The receipts appear on the audit trail as the following transaction types:

BR = Receipts from a bank account.
CR = Receipts from a cash account.

VR = Receipts from a credit card account.

ﬁ Bank Receipts = O X
© tielp

I 2B % &% B e @

Clear Payby Insert Remove Copycell Copy cell above Calculate Memorise Recall Print list Send to
foom card row (F7) row (F8) above (F6) +1 (Shift +F6) net (F9) Excel

Bank | Current Account 1 Tax Rate 0.00

N/C DE ICT Gﬁm dpital lnoome

1800 © 01/06/2025 DES 3921 5 TY Income 25... 22500.00 T9 0.00 22500.00

22500.00 0.00 22500.00

1. Bank accounts » Bank receipt » complete the window as follows:

Bank* From the drop-down list, choose the bank account you want to
receive the money.

Date* Enter the date of the receipt.

Ref Enter the reference you want to associate with the receipt.

N/C* From the drop-down list, choose the required nominal code.

Fund This only appears if you select Enable Charity/Non-Profit in Settings

» Company Preferences » Parameters.

From the drop-down list, choose the required fund.

Details Enter the details for the receipt.

Net Enter the net value of the receipt.

Tip: If you enter the gross value and click Calc, the net and tax
values calculate based on the tax code.
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T/C*

From the drop-down list, choose the required tax code.

Tax

This automatically calculates from the net value and tax code.

Tip: If required, you can over type this value.

Note: If you've already set up a Sage Pay account, you can use the Pay by Card option to post
the customer's credit card payment online.

*This information is mandatory

2. Save » Close
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3.7 Recurring Bank Entries

Most schools have regular payments such as standing orders and direct debits. e.g. lease
company payments. To save time and effort in entering the same details again and again
these transactions can be set as recurring entries.

Recurring entries can be set up in Bank accounts module.

Bank accounts/Recuuring items

Add / Edit Recurring Entry A

Recurring Entry From / To

Bank A/C* 1800 v Current Account 1

Nominal Code® 7300 v Leasing Expenses

Recurring Entry Details

Transaction Type Bank/Cash/Credit Card Payment v
Transaction Ref DD/STO

Transaction Details EMS Copier
Department® 0 v Default

Posting Frequency

Every* 0 Month(s) + Total Required Postings 12
Start Date® 01/09/2025 E Finish Date

Next Posting Date 01/09/2025 & Suspend Posting ? O
Last Posted

Posting Amounts

Net Amount 0.00 ¥  TaxCode* T9 0.00 ~ VAT 0.00 =

Calculate net OK || Cancel |

You can enter recurring entries for daily, weekly, monthly or quarterly time periods and you
can set up customer, supplier, nominal or bank transactions.

= Note: You must enter recurring journals as pairs of balancing debits and credits. If
m you enter just one side of the journal it results in an error message on posting the
recurring entry, to advise that there is an imbalance in debits and credits.
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To Set Up a Recurring Entry

1. Bank accounts » Recurring ltems » Add » Complete the Add / Edit Recurring Entry
window as follows:

Recurring Entry From / To

Bank A/C From
orTo

Choose the required bank account.

Nominal Code,
Customer A/C
or Supplier A/C

The Transaction Type determines what appears in this box. Choose
the required nominal code, customer account or supplier account.

Recurring Entry Details

Transaction
Type

Choose the required transaction.

Note: If you choose a journal credit or debit you must set up the
opposite journal with the same amount and posting frequency.

Transaction Ref

Enter the reference.

Transaction
Details

Enter the details.

Note: This option does not appear if it is a customer or supplier
recurring entry.

Posting Frequency

Every Enter the number for how often you want the recurring entry to be
posted and choose if this is days, weeks or months.
For example, if you enter 1 and choose Months this posts once every
month.

Start Date Enter the date you want the recurring entry to start from.

Next Posting
Date

This automatically calculates the date for when this recurring entry
next posts.

Last Posted

Shows the date for when the recurring entry was last posted. This is
blank if itis a new recurring entry.

Total Required

Enter the total number of postings you want to make.

Posting

Postings Note: To set a perpetual recurring entry, leave this at 0.

Finish Date This calculates automatically from the start date, posting frequency
and the total required postings.

Suspend Select this option if you want to temporarily suspend the recurring

entry.
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Posting Amounts

Net Amountor | Enterthe amount of the recurring entry. If it's a bank recurring entry
Amount enter the netvalue.

2. Click OK.
To Process the Recurring Entries
1. Bankaccounts » Recurring Items > Process.
2. In Show Due Entries Up to, enter the required date > Post.

By default whenever you start up Sage 50 Account the program will check your recurring
entries to see if any are due to be processed. A message will be displayed givin an option
to process them now. Click yes to be taken straight to the recurring entries screen, where
you will then be able to post them. Click no and be taken to the program as normal.

If you forget to process a recurring entry, the program will check back and complete any
entries that have been missed. Therefore never manually post an entry because you
forgot to process it.
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3.8 Bank Reconciliation

It's really important that the transactions in your Sage bank accounts match what has actually
gone through your bank account, so that you know your bank balances are correct. This also
helps you to ensure you manage your cash flow effectively.

Sage Accounts has a Reconcile option within the Bank to help you easily match each

transaction in Sage to your bank statements.

To reconcile your bank account
1. Bankaccounts » select the required bank account » Reconcile.

2. Complete the Statement Summary window as follows:

Statement Shows the bank account reference, date and statement number. You
Reference can change this to show your own statement reference.

Ending Balance | This defaultsto the current balance on the selected bank. Enter the
end balance from the actual bank statement you're about to reconcile.

Statement Date | Enter the end date of the actual bank statement you're about to
reconcile.

Interest Earned | If your bank statement shows any interest earned, enter the details in
these boxes.

Account If any bank charges appear on your statement, enter the details in
Charges these boxes.
Statement Summary #
o Help
Bank : 1800 Current Account 1
Statement Reference : 1800 2024-12-03 01
Ending Balance : 0.00 = Statement Date : 31/12/2024 =
MNeed to reverse a previous recondiliation for this bank account? Reverse a recondliation
Interest Earned :
Amount : 0.00 %  Date: 03/12/2024 = NC: W  TC: |T9 0.00 v
Account Charges :
Amount : 0.00 %  Date: 03/12/2024 = NC: w | TC: |T120.00 v
OK | | Cancel
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Statement reference 1800 2025-09-29 01 Ve Enddate  29/09/2025 End balance 877170.81 =
Un-matched transactions
Date 4 | No. |Reference|Details | Payments |
06/06/2025 18236 5567 EEC Exam Aide June 2025 1433.53
< m > Match >>
Date | No.|Reference |Details | Paymenfgas
O/Bal Last reconciled balance =
02/10/2017 839 613941 ariffins garden centre - ty 25.5 4
£ [} >
Matched transactions
Book Balance Total Payments  Total Receipts Matched Balance — Statement Balance = Difference
875737.28| | 4047.06| |  360428.72 | emmmsi| | smmasi] | 0.00|
| Save progress ” Reconcile ” Close |

Note that bank transactions can be entered while in the Bank reconciliation screen by clicking
on the relevant button across the top: Bank Payment, Bank receipt, bank transfer etc

&2 Reconcile - 1800 - Current Account 1 — (m] X
i
© Hep
= - - -

R ERABS L ® ™% & W

f View Report Bank Bank Customer Supplier Customer Supplier Bank  Printlist Send to

history receipt payment receipt payment refund refund transfer Excel
3. Click OK.

The Bank Reconciliation window shows the following:

Statement area

Unmatched items pane

Matched against statement pane

Book Balance
Totals area

Buttons

From the unmatched items pane, select and match the transactions to be reconciled. To

do this, either double-click each transaction or select the required transactions » Match.

CO TABLE OF CONTENTS
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To un match transactions that you have matched in error, from the matched against
statement pane either double-click each transaction or select the relevant transactions >
Un match.

To post an adjustment H Adjust H select the adjustment type you want to post » OK »
enter the transaction details H Save H Close.

The Save option enables you to save the reconciliation part way through and reopen it
later

Once you have matched everything to your bank statement > print the report >
Reconcile.

If the value of the matched transactions is not the same as the statement end balance the
Reconciliation Difference window appears, and you can either:

Add Adjustment | Selectthe adjustmenttype you want to post » OK > enter the
transaction details » Save » Close.

Ignore This option flags all of the transactions in the matched against
Difference statement pane as reconciled.
Cancel To return to the Bank Reconciliation window, click Cancel.

The Bank Reconciliation Report can be printed

a.

Before you press the reconcile the icon you can print the reconciliation report
or

If you have reconciled the account and any time up to the start of the new months
reconciliation, you can go back into the reconciliation for the month with the relevant date
and closing balance and run the bank reconciliation report.
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3.9 Bank Reports

Print the bank reports for all bank, credit card, debit card and cash accounts at end of each
month and file in Bank File reports.

—_

Bank Payments

2. Bank Receipts

3. Unreconciled Bank Transactions
4

Bank reconciliation report —print within Bank Reconciliation section

Date: 29/09/2025 FSSU Demo data Aug 25 Page: 1
Time: 12:34:14 Bank Reconciliation

Bank Ref: 1800 Date To: 29/09/2025
Bank Name: Current Account No.1 AIB 02242175 Statement Ref: 1800 2025-09-29 01
Currency: Euro

Balance as per cash book at 29/09/2025: 875,737.28

Add: Unpresented Payments

Tran No Date Ref Details €
18236 06/06/2025 5567 EEC Exam Aide June 2025 1,433.53
1,433.53
Less: Outstanding Receipts

Tran No Date Ref Details €
0.00
Reconciled balance : 877,170.81
Balance as per statement : 877,170.81
Difference : 0.00

¢ TABLE OF CONTENTS n



FSSU SAGE Accounts Manual Section 3: Bank Module

3.10 To Cancel Old Cheques

If you have made a mistake, such as entering a cheque from or to the wrong account, or if
you have entered a cheque against the wrong invoice, they can be corrected on the bank
account activity screen by selecting the edit transaction button along the top..

Cancel old outstanding cheques.

= Make a list of the cheques that need to be cancelled. The list should state the cheque /
payment reference, payee, amount and nominal code.

= Goto Bank Accounts » Bank Receipt

= Select the bank account

= Enter the details of each payment on the cancel list and save.
= Goto Bank Accounts » Reconcile

= When reconciling the bank account match the outstanding cheques to the receipts
entered above.

Note that by clicking the show detail button, this will give additional information as to where
the transaction was coded to.

€5 Activity - O X
© Help
=
2 B E R ® - &
View Edit Delete  View Hide Show  Printlist Send to
transaction transaction transaction item ¢ detail Excel
1800 v [Current Account 1 \
Show: All Transactions v Date: [01/01/1980 to 31/12/2099 |  Type: [al Trans. | 1to24

Detal

1BR 30/06/2025 DES ICT Grant 22500.00 R 30/11/2025

L]

[+ 2BP 01/08/2025 Datapac Laptops, Annual Licence 15180.00 R 30/11/2025

[+ 4 BR 01/08/2025 Doc 3 TY Income 25 26 590.00 R 30/11/2025

[+ SBR 01/06/2025 DES TY Income 25 26 22500.00 R 30/11/2025
61C 01/08/2025 TRANS Bank Transfer 200.00 R 30/11/2025

[+ 10 BP 01/08/2025 123 Joe Bloggs Repairs 8000.00 R 30/11/2025

15 PP DOHO01 31/10/2025 Purchase Payment 3700.00 R 30/11/2025

| 4600000/  27080.00]
Balance: | 19010.00

Dept|Name

7/11/2025 LBCOO1
07/11/2025 1 0 Local Badminton Club 500.00 to SI117

0 Local Badminton Club Sales Receipt
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3.11 Introduction to Bank Feeds

Bank Feeds in Sage 50 Accounts V30 & above

Bank feeds are connections that automatically download transactions from your bank account to
Accounting software. You can then work with the data by creating new transactions as needed or
match bank transactions to your Accounting transactions. Using bank feeds greatly reduces the need
to create manual entries, which simplifies bank reconciliation, ensures your accounts are up-to-date
and accurate, and saves you time. You can have an unlimited number of bank feeds. However, you
cannot link to a Loan, Cash, or other account types.

Getting started with Bank Feeds:

1. Click Bank accounts and click Get started for the bank record you want to connect to.
2. Click connect under Automatic heading and continue

3. Enteryour First Name and Last Name then click Yes, | am the right person.

4. Check your company information is correct, then click Continue.

Activate

1. Bank Feeds

Connect your Sage account

File Edit View Mod
Home
Apps and add-ons
Business dashboard

Bank accounts
Supplers 1850 - Credit Card Account O

(+* Connected Open
Bank accounts
Bank feeds ‘ 1800 - Current Account 1 Connect bank
MNominal codes ‘ 1801 - Current Account 2 Connect bank
Transactions

‘ 1802 - Current Account 3 Connect bank

Departments
Diary

Connect your Sage account

5. If you have a Sage account login, enter your login details, click Log in then continue
to step 9.
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6. If you don'tyet have a Sage account, click Create account.

7. Enter your details, enter and confirm the password you want to use, then click
Sign Up.

8. Check your emails and enter the verification code you've received, then click
Continue.

9. When the Success! Your company is now connected window appears, click

Close.
Click Connect bank
File Edit View Mog
Home
Apps and add-ons
Business dashboard
Bank accounts
SEpes 1850 - Credit Card Account O
(. Connected Open
Bank accounts
Bank feeds ‘ 1800 - Current Account 1 Connect bank ‘
Nominal codes ‘ 1801 - Current Account 2 Connect bank ‘
Transactions
‘ 1802 - Current Account 3 Connect bank ‘
Departments
Diary

https:faib.ie/

E Allied Irish Bank (IE) - Personal

We will connect directly to your bank, or through our secure partner. We can then download your bank transactions.

What’s needed to connect?

s Have your sign-in credentials on hand for when you're asked to sign into your bank.
Note: For security reasons, you'll be periodically prompted to sign inte your bank account.
s Be prepared to enter the start date for downloading transactions. Some banks limit this start date to the last 90 days.

1. In the Bank Feeds window, ensure the correct Country is selected, then either use
the Find your bank box to search for your bank, or select it from the list under Or
choose from these banks.
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Connect your bank

download them as soon as possible.

Reduce labor-intensive data entry by connecting Sage to your online bank. We’ll automatically check for new transactions on a daily schedule and

Bank of Ireland (IE) -
Business On Line

-~
S

*2 Ulster Bank

Find your bank
‘ Q ‘ Ireland -
Or choose from these banks
Allied Irish Bank (IE) - Allied Irish Bank (IE) - s Bankof Ireland (IE) - 365
Personal Business = online

.,
' permanent tsh

2. After clicking your bank name, click Continue then fo
instructions to connect to your bank. These steps are
include entering your online banking credentials.

AlB

Share your account data
with Sage using Plaid

Log in
@ Share your data securely
You'll be taken to your bank to

authenticate and share your data,

Registration number

You're always in control
5-digit Personal Access Code (PAC) Plaid doesn't store your login
details and you can stop sharing
your data at any time

Cancel

CO TABLE OF CONTENTS

llow the on-screen
unique to your bank and may

e

Review the types of
financial data you’'ll share
Sage is requesting access to the
following types of financial data to
provide their services to you:

.

2 Account Transactions v

B Account Details v

By clicking "Allow” you agree to Plaid retrieving the
above data for 180 days and sharing it with Sage.
See our Terms for more info.

Cancel
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3. Next, in Download starting from select the historical date from which you want to
start downloading transactions, usually the first date after the last bank date that
the account was reconciled in Sage 50 and then click Continue.

From what date do you want to download transactions?

Typically, the download date is for the previous 30 days or from the latest reconciliation date.

Download starting from

01/01/2024

Note: Some banks allow you to download the last 90 days of transactions only.

Bank account connected

el hownbees i Lransss o o pow band sesount shen your bank suthorisss te feed.

Fle Edit View Mog

Home
Apps and add-ons

Business dashboard

Suppliers

Bank accounts

Bank feeds Welcome to Bank feeds

Bank transactions effortlessly flow into Sage 50 Accounts, allowing you to easily match them
with your Sage transactions.

Mominal codes
) To set up Bank feeds, click Connect bank for the account you want to connect.
Transactions Once connected, click Open to match your bank and Sage transactions.

1800 - Current Account 1 o
Diary (& Conneated ) Open
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Download from your bank

You can download transactions as often as every 15 minutes. New transactions are downloaded
automatically when you first open the bank feed for your bank account.

1. Click Bank feeds, then click Open for the bank account you need to work with:

1200 - Bank Current Account

[« Connected

2. Click Download, then click OK.

| Auto-match Recurring items

3. When transactions are manually downloaded, once the download is complete the below
confirmation message is shown:

o Download transactions

The download completed successfully.

OK

Auto-matched transactions

We'll always try to automatically match your bank feed transactions with Sage transactions. If a match
is found this will be shown in the Auto-matched section:

<— 1200 - Bank Current Account

Confirmed | Last downioss cate I "
07155 | 1/07/2023 10z | e bonkbansacions p o =]

‘ Auto-match H Recurring items. H View ignored H Manage rules

I Auto-matched (2) I Tobe matched (157 Confitmed (0)

| Unmatch st |

Bank transactions (2)

Sage transactions (2)

515 01/01/2022 | test transaction description t .15
Contim | Unmatch G )

£5.15

017017202 test ransacton desciption tes_transaction eference

Confiem | ynmaten
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19/ Bank feeds X

How to match your transactions

Simply drag your bank transaction over to the desired Sage transaction, or vice versa, and drop. Alternatively, you can click the

relevant bank and 5Sage transactions to select them and then click Match selection.

e Show me how
-
o Creating a new Sage transaction .
| If you don't have a Sage transaction to match against a bank transaction, simply click the Create option on your bank

transaction, choose the type of Sage transaction you'd like to create and enter the transaction details.

04/04/2023 | BANK FEE £87.50 / £87.30
| 4 { Money out Create
. ns

Part-matched transactions

If the value of the bank and Sage transactions do not match exactly, a Part-matched badge is shown. When the amounts sp
= match, the transactions are moved automatically into the Confirmed tab. While transactions are part-matched, you can create

a transaction for the remaining amount. Note: Only one part-matched transaction can exist at any one time.

04,/04/2023 |8\525 15-775 £54.90 / £30.90 04,/04/2023 | 8525 15-775 £24.00 / £0.00
BP | 5000

— Money out ) [ Part-matched ) Clwl Unmatch (_Mi‘“!} out ] Unmatch
]

Ignore transactions
| | To ignore a transaction, for example a duplicate, simply click to highlight it then click Ignore selection. Ignored transactions
B are automatically moved to the Ignored transactions screen.

Clear selection | Mz ction | Create transaction

= To view the ignored transactions screen, click the View ignored button where you can see all ignored transactions and restore
0 them, if needed.

MNext step
L To review all confirmed matches, click the Confirmed tab.

[[] Don't show me this again m
IA119E0EOTOAD Davsnes ANONOTI0AL A0 £34 &0 £ £2150 |
&— 1800 - Current Account 1 Auto-match
c:“:’;:d ::;',:‘:,"2“:: : :;: og | Imcude bank ransactins up to:
Auto-matched (3) | To be matched (35) Confirmed (0)
Clear selection | Confirm selection | Confirm all | Unmatch selection | Unmatch all | Ignore selection
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| | Confirm all| | Unmatel
Bank transactions (3) Sage transactions (3) —
15/01/2024 | D/D Revenue Commis IE24011260697949 RevCom-0099877961-10C108 €150 15/01/2024 | 2 €21.50
8P| 2260 11
vat
(Money out ) (Matched ) Confirm | Unmatch (Money out ) ((Matched )
15/01/2024| D/D Zurich Life IE24011159247835 €207.99 15/01/2024|3 €207.99
BP|2240| 12
Zurich
(Perrow) (e Conirm | unmateh (o) (med)
19/01/2024 | VDC-ROUNDWOOD PHAR €40.21 17/01/2024| 5 €40.21
8P| 4671| 14
Pharma
(Money our) (Watched ) Confirm | Unmatch (Poney our) (Matehed )

Auto-matched (3) | To be matched (35) Confirmed (0)

To be matched
If a downloaded transaction is not yet posted in your accounts, you can create it.

You can either drag and drop the transactions from either side of the window to match them up or
click to select each transaction and then click Match selection to match them.

Auto-matched (2) ITn be matched (157) I Confirmed (0)

Clear selection | Match selection

P—— , P——
01/01/2022 | test_transaction_description test_transaction_reference £5.15 7 £5.15 |~ 04/07/2023 £5.15 / £5.15
BR | 4000
=) Create D)
=
‘ 01/01/2022 | test_transaction_description test_transaction_reference £5.15/ £5.15

Note: Matched transactions will vanish from the list and be visible in the Confirmed tab
m instead. See section 4 below for more information on confirming matches.

Create transactions

If the transaction doesn't already exist in Sage, you can click Create to make a new transaction in Sage for
the selected bank transaction

01/01/2022 | test_transaction_description test_transaction_reference £5.13 [ £5.15

MMoney in Create
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The following window will appear:

Create trans

Create money in transaction

Select the type of transaction you want to create then click, Create transaction.

fﬁ Bank receipt £5.15
D. Customer receipt £5.15
«=  Supplier refund £5.15
@& Bank transfer £5.15

Create transaction | | Cancel |

Simply select the type of transaction you need to create, then click Create transaction. You'll then be
taken to the right banking area to record the transaction.

If you want to learn more about creating transactions, check out Sage’s help article about this here.

Confirming your matches

Confirming your matches removes them from the bank feed and flags the transactions as matched.

= To confirm matches and continue to your bank reconciliation, click Save and continue to
reconcile

= If you don't want to do a bank reconciliation yet, to confirm matches and close Bank feeds,
click Save and close



https://gb-kb.sage.com/portal/app/portlets/results/viewsolution.jsp?solutionid=222001000100046&page=1&position=0&q=create%20transaction%20in%20bank%20feeds
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Reconciling your bank account if you use Bank feeds

Summary
This guide explains how Bank feeds speeds up your bank reconciliation process in Sage 50 Accounts.
Description

When you match transactions within Bank feeds, the relevant transactions are automatically matched
within your bank reconciliation, saving you valuable time. The bank reconciliation process is still the
same process you're used to, but with less transactions to manually match.

Reconcile your bank account

D

> \'/',_ TIP: To reconcile straight after using Bank feeds, simply click Confirm and continue to
" reconcile within the Bank feeds window.

Save and continue to reconcile

1. Click Bank accounts, select the relevant account then click Reconcile.
2. Complete the Statement Summary window as normal then click OK.

3.  When the Reconcile window appears, any transactions you've already matched through
Bank feeds appear in the matched transactions pane.
In the Matched transactions pane, check the Last reconciled balance is correct.

4. Check and match any unmatched transactions if required, for example, if you have
unmatched transactions dated before you started using Bank feeds.

5. Check the Matched Balance and the Statement Balance are the same, then click
Reconcile.
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2. Create Rules

With Bank Feeds Rules it's easy to automate your regular bank transaction postings, reducing the time
you spend processing. As you match transactions in Bank feeds, if you match a transaction that you
know occurs on a regular basis, you can quickly create a rule to post future ones automatically.

Set up a Bank Feeds rule
a. Open the Bank feeds window and download transactions.
b. Match the bank feed transaction(s) with the relevant Sage transactions.

c. Navigate to the Confirmed tab, and select the transaction you want to create a rule for
and Click the Create rule link

Clear selection | Select all | Unmatch selaction Export

d. In Give your rule a name, enter a new name for the rule.

Create rule
Create rules to automatically categorise and set details on bank transactions with the conditions you choose. By
doing this, you can save on processing time and handle transactions with ease.

E Rule will only apply to newly downloaded transactions.

Matched transaction details

Date ‘ Bank account Reference Amount

01/01/2022 1200 - Bank Current Acco... test_transactio... £5.15

Basic information

Rule name * | |
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e. Setone or more conditions that will be used to identify future transactions to automate:
= The Reference is shown against the transactions from your bank

= Ifthe Amount can vary, don't include the amount as a condition

v ls

.

- TIP: You can use any of the conditions listed, just tick the one(s) you want to
use.

1II©l

Condition(s)

Select one or more of the following conditions *

EEEs e

Reference Equals - | test_transaction_description hest|

vl Amount | Equals - ‘ | 515 |
[ Dayof month | Between ‘ 1 ~ | and -
]  Cheque number | Equals ‘ | |
[]  Account number | Equals ‘ | |
[l Sortcode | Equals ‘ | |

f. Inthe Transaction details section, you can specify the information you want on the
transaction that is posted from the rule.

g. Inthe Auto posting section, choose if you want to review transactions before they're
posted, or if they'll be automatically posted without approval.

Note: You can change this option later if required. The Rule approvals tab in
the bank feed will appear when approvals are needed, or if using auto posting
the transactions will appear on your next bank reconciliation automatically.

You've now set up a Bank feeds rule.

Note: New rules will only apply to feeds downloaded after the rule has been
created, they are not retrospective.
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Approving transactions

If you have set up your bank feeds rules to be approved before posting transactions to your accounts,
you'll need to approve them from the Rule approvals tab in your bank feed.

Approving transactions

If you are happy with the proposed transactions, to approve them:

1. Inthe Rule approvals tab simply select the transaction(s) you want to approve by clicking
them.

2. Click Approve selection.

AL

;@»_ TIP: If you want to approve all transactions in the list, you can also click Approve
= allinstead.

Rejecting transactions

If you need to reject a rule approval:
1. Inthe Rule approvals tab, select the transaction(s) you want to reject.

2. Click Reject selection.

LG
N

:O:' TIP: To reject all rule approvals, just click Reject all.

S

Manage rules

Managing your bank feeds rules is a simple and intuitive process in v30 and above, with an all-new Ul and
enhanced functionality.

Resolution

To manage your bank rules:
1. Click Bank Feeds.
2. Click Open on the bank feed you want to look at.
3. Click the Manage rules button:

‘ View ignored

‘ Auto-match H Recurring items
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Once the manage rules window opens, you have several options:

Manage rules for 1200 - Bank Current Account = m] K

@ Help

m The rules you set up will automatically categorise your transactions. Only one rule can be applied per transaction. ‘

2
1

<) & K

testl

3 of 300 available rules

View/Edit rule | Delete rule || Close |

View/Edit rule
Click to select the rule you want to view or edit, you can then view or make changes as needed.

-g Note: You can't change a rule name once saved.

Delete rule
Click to select the rule you want to delete, then click Delete rule.

(=] Note: It's not possible to recover deleted rules. If you delete one by mistake, you'll have to

-g re-create it.

Auto post
You can quickly change the auto posting settings for your bank rules, just tick or untick the Auto post
option and your rule updates automatically.

(=] Note: This setting takes effect the next time it's triggered and won't affect transactions that
-9 are matched with arule.

Automatic rule retention

(=]
ﬂ Note: This only applies to Sage 50 Accounts v30.1 or above.

When using bank rules, they're automatically restored if you re-connect your bank feed. In previous
versions your bank rules were deleted if you disconnected your feed.

You don't need to do anything, just connect your Bank feed and they'll be right where you left them.
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4.1 Introduction

You can use the Nominal codes module to customise Sage Accounts and make management
reports and transactions more relevant to your school. It's also a great place to see
information about the transactions affecting specific nominal codes.

Within the Nominal codes module you can access your chart of accounts, edit nominal
codes and post journals.

New Opens a blank nominal record, where you can:
Create a nominal account record.
Open an existing nominal account record to view or edit. To do this, from
the N/C drop-down list » choose the required nominal record.

Edit Opens the selected nominal record to view or edit.

Wizard Opens the New Nominal window.

Activity Opens the Activity window.

Journal Entry

Opens the Journal Entry window.

Journal DO NOT USE see section on reversing journals 4.6

Reversal

Prepayments Opens the Prepayments window.

Accruals Opens the Accruals window.

Budgets Opens the Budgets window.

Chart of Opens the Chart of Accounts window.

Accounts

Trial balance Use this option to run a Period Trial Balance Report.
You can use this report to check the balances on your nominal codes and
ensure that the debt and credit values are equal.

Profit & loss Use this option to run a Profit & Loss Report.

This report details whether or not your organisation is trading profitably.

Balance sheet

Use this option to run a Balance Sheet Report.

This report details your company assets and liabilities, and provides a
summary of your current financial position.

Comparative

Use this option to run a Comparative Profit and Loss Report.

profit & loss This report compares actual profit and loss values for a period with the
budget or prior year values.
Variances Generates the Budget Report.
Identifies variances between your budget figures and your actual figures.
Prior year Use this option to run a Prior Year Report.

This report compares the current trading activities to the same period last
year.
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Delete Deletes the selected nominal code.

Expand all Expands out the tree view so all of the codes are visible
Collapse all Collapses the tree view so only the main categories are visible,
Print list Prints the list of nominal codes.

Tip: If you have afilter applied to the list, the Print list option only prints
the filtered nominal codes.

Send to Excel

Sends the list of nominal codes to Excel.

Tip: If you have a filter applied to the list, the Send to Excel option only
sends the filtered nominal codes.

Reports Opens the report browser for the Nominal codes module.
List Changes the display of your nominal codes.
Analyser Changes the display of your nominal codes.

The Analyser view displays your nominal codes as a simple list without
any grouping or filters applied. The debit and credit columns display
cumulative totals for the current financial year, including any brought
forward values.
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4.2 FSSU Chart of Accounts — Nominal Groups

Click here to access the chart of accounts
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4.3 Creating New Nominal Codes

To create a new nominal code go to Nominal Codes » Wizard and this opens New Nominal

Window.

1. Enter the nominal account details as follows:

Name

The name of the nominal account, up to 60 characters.

Tip: This appears on all financial reports.

Type

The area you want to assign the nominal account to.

A nominal accountis assigned to a specific area in the profitand loss
or the balance sheet.

By default, these areas cover:

- Income and Expenditure: Des income, School Generated Income,
Other Income Education Salaries, Education Expenses, Repairs
and Maintenance, Administration Expenses and Financial
Expenses.

- Balance sheet: Fixed Assets, Current Assets, Current Liabilities,
Long Term Liabilities and Capital & Reserves.

Category

The account category for your new nominal account.

Each area in the Income and Expenditure or balance sheet is divided
into category accounts, which appear as headings on all financial
reports.

N/C*

A unique reference code used to identify the nominal account. You
can't change this once you save the record.

The code must be numbers only and have at least four digits and no
more than eight, between 0001 and 99999999.

We recommend:

- The number of digits in a code are consistent. For example, you
can't have some with four numbers and others with six.

- You allocate a code so that the nominal account groups with
associated accounts. For example, group all your income nominal
accounts within arange. This ensures the nominal accountis
included and used in the correct financial report.

* This information is mandatory.

Section 4: Nominal Module
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2. Next » to create a nominal account with no opening balance select No, there is no
opening balance to enter » Create. To create a nominal account with an opening balance,
select “Yes, | wish to enter an opening balance” > enter the opening balance details as

follows:

(= | Note: Entering opening balances covers a number of activities that are done
m in a set order. Unless you are familiar with opening balances and the process
involved, we recommend you don't enter an opening balance at this point.

Type*

Choose the transaction type associated with the opening balance:

Debit balances usually include fixed assets that aren’'t overdrawn,
purchases and overhead accounts such as electricity charges.

Credit balances usually includes loans and income accounts such as

sales.

Date*

Enter the date that you want to use for the opening balance.

Tip: It should match the last day of your previous accounting period.

Reference

O/Bal is a standard reference and helps to identify opening balance
transactions on the audit trail. You can change this if necessary.

Amount*

Enter the gross amount of the opening balance.

* This information is mandatory.

3. Click Create

New Mominal

Enter Details

Opening Balance

Nominal Information

Enter Details

To create a new nominal account, you need to enter the nominal accounts name and select the type

of nominal account that you are creating.

The new nominal account can be given a category within the chart of accounts and a unique reference

code to identify the account.

MName
Type
Category

Nfc=

| School Uniforms

|Inoome

|Sd'|oo| Generated Income

7

Cancel
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Amending a Nominal Code

List the nominal codes and select the code you want to amend and click the new/edit drop-
down. You can amend the name, budget figures and prior year figures at any time however
the code numbers cannot be changed once created.

Deleting a nominal code

List the Nominal Codes and select the code you want to delete and from the toolbar click
Delete

You cannot delete an account if any of the following apply:
= The account has a balance
= The account has a transaction history

= Theaccountis reserved as a Control Account.

Instead, the account can be made inactive by clicking on the inactive button and click save.

LY Nominal Record - July Provision Grant

l B &

Clear Delete Send to

form Excel
N/C* 3293 v Inactive 0e
Name July Provision Grant

Aty Balance 0.00 Account Type  Nominal Account

Graph
B/F 0.00 0.00
Sep 0.00 0.00
Oct 0.00 0.00
Nov 0.00 0.00
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4.4 Entering a Nominal Journal

You can use journals to transfer balances between nominal codes. You can also use journals
to correct balances as they don't affect customer or supplier accounts.

Journal transactions are always posted with an equal value in the Debit and Credit columns,
with at least one journal debit and one journal credit per journal posting.

To post a journal

1. Nominal codes » Journal entry.

2. Check or enter the following information:

Reference Areference for the journal, up to 30 characters.

Posting Date The date you want to post the journal.

Balance This is the difference between the debit and credit values for the
journal.

Tip: Before you can save the journal the balance must be zero.

N/C* The nominal account code you want to affect this part of the
transaction.

Name The name of the nominal account code you have entered.

Ex. Ref An additional reference to further identify the journal, up to 30
characters.

Department - The department number for the transaction.

Details A description for the transaction, up to 60 characters.

T/C* The appropriate tax code for the transaction.

Debit Enter any debit value here.

Credit Enter any credit value here.

* This information is mandatory.

3. Repeat step 2 until you've entered all the lines of the journal » ensure the debit and credit

values match.
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4. Complete the Journal Entry window by clicking one of the following options:

Save Save the journal and create the transactions.
Discard Clear the information you have entered.
Print List Print the journal.

To Excel Sent the information to an Excel spreadsheet.
Close Close the Journal Entry window.

E Journal Entry

= = X
@ telp
il 2B 5 F e b = &
Clear Insert Remove Copycell Copy cell above Memorise Recall Add Print list Send to
form row (F7) row (F8) above (F6) +1 (Shift + F6) attachment Excel
Reference Posting Date Balance
31/08/2025

Cy ©

5010 Caretaker Wages Expense Caretakers PAYE/PRSI T 650.00 0.00
2250 PAYE/PRSYUSC/LPT Control Account 0 T 0.00 650.00
| v

650.00 | 650.00
Reverse Journals [[] Reversing Date 31/10/2025
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4.5 Posting RCT and VAT Journal

Introduction

School Boards of Management are principal contractors for the purposes of RCT as schools
fall within the definition as defined by legislation “any board or body established by or under
statute ... and funded wholly or mainly out of funds provided by the Oireachtas”.

School Boards of Management can be involved in a range of activities including: Construction
Projects, Summer Works, Emergency Works, Major Devolved Projects, Additional
Accommodation Schemes as well as day to day repairs that bring them within the scope of
Relevant Contracts Tax (RCT) and, as a consequence, Value Added Tax (VAT).

Posting to Sage Accounts

Journal entries will be used to process the RCT and VAT.

Example

Mr Joe Bloggs paints the school for €10,000 and gives an invoice to the school excluding VAT.

c. The school enters the details on ROS (Revenue Online System)and ROS notified the
school to deduct RCT.

RCT @ 20% = €10000 * 20% = €2000
d. The school pay Mr. Joe Bloggs €8,000 (€10,000 - €2,000)

e. The school as Principal Contractors must pay the VAT to the Revenue and the VAT is
Reverse Vat @13.5% = €10000*13.5% = €1,350
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1. Enter the payment on SAGE using Bank Accounts/Bank Payment

Q Bank Payments

Il = 828 82 9 ¥ B Moo d

Clear  Print Insert Remove Copycell Copy cell above Calculate Memorise Recall Print list Send to
form Cheque row (F7) row (F8) above (F6) +1 (Shift +F6) net (F9) Excel

Bank | Current Account 1 Tax Rate [ 0.00|

N/C Repairs to Buildings and Grounds

1800 © 01/08/2025 123 5310 0 Joe Bloggs Re... 8000.00 T9 0.00 8000.00

8000.00 0.00/  8000.00

2. Enter the RCT and Vat liability using a Nominal Journal.

Nominal codes/Journal entry

E Journal Entry

= (m] X
@ telp
i1 2B T ¥ B b =& &
[lear Insert Remove Copycell Copy cellabove Memorise Recall Add Print list Send to
orm  row (F7) row (F8) above (F6) +1 (Shift + F6) attachment Excel
Reference Posting Date Balance
01/08/2025 0.00

2260 Reverse VAT Control Account 0 Joe Bloggs VAT T 0.00 1350.00

2270 RCT Control Account 0 Joe Bloggs RCT T9 0.00 2000.00
5310 Repairs to Buildings and Grounds E... 0 Joe Bloggs VAT RCT i) 3350.00 [N ¥
|

| 3350.00 3350.00 |

Reverse Journals [ Reversing Date  31/10/2025 *
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3. Payments to Revenue

To verify the balances owing to Revenue for RCT and VAT go to Nominal Codes/Activity.
Enter the nominal code ,the date range and run the report.

€5 Activity = O X
© Help|
=3 - -
B B B E = &
View Edit Delete View Print list Send to
transaction transaction transaction item o Excel

v | Reverse VAT Control Account

Show: Custom Range... v Date: |01/01/1980 to 31/12/2099 |  Type: | Al Trans. |1t0 13

No  [Type |Date Ref. Ex.Ref Dept|Details Amount

11 X © 01/08/2025 0 Joe Bloggs VAT 1350.00

RCT: The entries in the RCT Nominal account 2270 must be verified to the Revenue
Deduction summary each month and the agreed amount will be settled via ROS on
the 23rd of the following month. The payment is entered using Bank Accounts/Bank
Payment to nominal code 2270.

VAT: The entries in the VAT Nominal account 2260 must be checked and the balance due
entered on the VAT 3 form on ROS and the amount settled with the Revenue on a bi-
monthly basis. The payment is entered using Bank Accounts/Bank Payment to nominal
code 2260.
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4.6 Entering Reversing Journals, Accruals and

Prepayments

WARNING: THE JOURNAL REVERSAL ICON ON THE TOOLBAR
DELETES JOURNALS THEREFORE IT SHOULD NOT BE USED FOR
ENTERING REVERSING JOURNALS

To enter reversing journals, accruals and prepayments please use the
normal journal entry and click Reverse Journal.

To activate this this feature, select Settings » Company Preferences » Parameters tab:

Company Preferences | £ |
Accountant | Budgetin VAT Sage Pay
Details | Labels Reporting
Call Charges
Default call charge rate
Transaction Processing
[#]Display Account Status
When I place an Account on Hold
{")Show a warning on each change
(®)5top the Account
Others
[CExdude deleted transactions [#]Login Chedk
[“]|Display ActiveSearch Popup [IMo Recurring entries at startup
[#] Access Rights [JEnable Project Costing
[Jallow Negative Stock [CJEnable CharityMon-Profit options
[¥]Copy skeleton journal values [#]Enable Smart Totals
[ Timeslips Link [#]Log Events
[¥]Enable Reversing Journals [JPause outside Finandal Year message
o J[owe

When entering a reversing journal check the box at the bottom of the window and specify a
date for the reversal. This enables SAGE to post both journals at the same time.
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4.7 Departments

Departments can be created through Departments in the toolbar.

Select Modules » department and select a department to edit and click on the Edit button.
In the Details section the department can be given any name up to sixty characters.

In the memo section, attachments such as the Department remittance or details of how the
grants can be spent can be added and saved.

Click

Apps and add-ons

isiness dashboard

Customers
Invoices and credits

Suppliers

Bank accounts
Bank feeds

Transactions

Department Record X
© nelp
O 2 O =
Add Open Delete  Properties
Details
_ Name Date modified Type Size
This folder is empty.

Save
File Edt View Modules Settings  Connected services Tools Favourites  WebLinks Software update:
Home

¥ e B 25 & &

Edit Activity Budgets Departmental Departmental Swap Clear Printlist Sendto Reports
profit & loss balance sheet Excel

I Refresh I\ I Filter ] All records (

a |y

Name

0 Default

1

2

3 TY Income in advance
4

5 ICT Grant 2025

6

7
8
9

_i;_

Every transaction entered on Sage 50 has a department reference.

The default department is O for standard grants such as capitation and standard day to day
school running costs.

When recording financial transactions in Sage 50 always ensure to allocate the appropriate
department and this will facilitate accurate reporting on the relevant department heading.
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When to use Departments?

Providing a breakdown of a nominal code:
= Income received in advance

= Grants received in advance

= School Tours

= Subjects

Providing financial analysis of specific key school transactions

= |CT Grant and related expenditure

= Free schoolbook grants

= Building Grant and related expenditure
= Ringfenced Grants

Department Reports

Departments » Reports > Nominal analysis

All reports | Department reports

Bl 8O BRATH LR «

Expand Al Collapse All Nominal analysis
Fevourkes Use these reports to view the debits and credits posted to the nominal codes. Each report provides
Report finder
Recent reports
> All reports
Advanced budgets Name
Balance sheet
e ¢ Departmental Analysss (Totak)
My department reports
Nominal analysis ¢ Nominal Departmental Analysis (Detaled)
Profit and loss

Variance
Nominal Ledger Departmental Analysis

Examples of reports

To show the breakdown of Income in advance by Income type

Criteria for Departmental Analysis (Totals) X

Criteria Values

Enter the values to use for the criteria in this report

Nominal Code |Between (inclusive) v |[2105 ~] and [ATE ~]
Transaction Date |Between (inclusive) v | [01/09/2024 v and [31/08/2025 =],
Transaction No |Between (inclusive) ~|[7 =] and [99999999 =
Department |Between (inclusive) v || =] and [999 =
Preview a sample report for a specified number of records or transactions (0 for all) o 3

Hep | [ o ]| coxa |
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Output:
- i 5 "
. 1 | 2 3 LI 4 | S 6
| Date: 04/11/2025 FSSU Master Chart of accounts New
: [ 1580 Departmental Analysis (Totals)
N/C From 2105 Tran Date From 01/09/2024 Tran No From 1
| N/CTo 2105 Tran Date To 31/08/2025 Tran No To 99,999,999
Dept Number t Name Debit Credit
3 TY Income in advance 590.00
T‘ 590.00
A nominal analysis of the ICT Grant and related expenditure
Criteria for Nominal Departmental Analysis (Detailed) X

Criteria Values

Enter the values to use for the criteria in this report

Nominal Code |Between (inclusive) v || | and [99999999 ~]
Transaction Date |Between (inclusive) | [01/09/2024 v | and [31/08/2025 ~l.
Transaction No |Between (inclusive) v |[1 =] ond [99999999 =
Department |Between (inclusive) v |[5 = ond [d =
Preview a sample report for a specified number of records or transactions (0 for all) o 4

hoo | ok ] come |

Output:
Date: 04/11/2025 FSSU Master Chart of accounts New Page: 1
Time: 16:27:13 . - <
Nominal Departmental Analysis (Detailed)
N/C From Tran Date From 01/09/2024 Tran No From 1 Department From 5
N/CTo 99999999 Tran Date To  31/08/2025 Tran No To 99,999,999 Department To 5
Dept Number 5 Dept  ICT Grant 2025
N/C 1461 Name  Capital: ICT Additions
Tran Number Type Date Details Debit Credit Balance
2 BP  01/08/2025 Laptops 15,000.00 15,000.00
Account Totals 15,000.00 15,000.00
N/C 1800 Name  Current Account 1
Tran Number Type Date Details Debit Credit Balance
1 BR 30/06/2025 ICT Grant 22,500.00 22,500.00
2 BP  01/08/2025 Laptops 15,000.00 -15,000.00
3 BP  01/08/2025 Annual Licence 180.00 ~180.00
Account Totals 22,500.00 15,180.00 7,320.00
N/C 3921 Name DE ICT Grant Capital Income
Tran Number Type Date Details Debit Credit Balance
) | BR 30/06/2025 ICT Grant 22,500.00 <22,500.00
Account Totals 22,500.00 22,500.00
N/C 4410 Name  Non Capital Computers / ICT Expense
Tran Number Type Date Details Debit Credit Balance
3 BP 01/08/2025 Annual Licence 180.00 180.00
Account Totals 180.00 180.00
Department. 32,680.00 31,680.00
Grand Totals 37,680.00 37,680.00
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Summary report for ICT Grant

Criteria for Nominal Ledger Departmental Analysis X

Criteria Values

Enter the values to use for the criteria in this report

Nominal Code |Between (inclusive) || v | and [99999999 ~|
Transaction Date |Between (inclusive) | [01/09/2024 v | and [31/08/2025 ~] .
Transaction No |Between (inclusive) v |[1 = and [99999999 =
Department |Bemon (inclusive) :_“5 - ond [g H
Preview a sample report for a specified number of records or transactions (0 for all) m

Help | OK I Cancel l

Output:
Date: 04/11/2025 FSSU Master Chart of accounts New Page: 1
e 16:13:22 Nominal Ledger Departmental Analysis
Nominal Code From: Tran No From: 1
Nominal Code To: 99999999 Tran No To: 99,999,999
Tran Date From: 01/09/2024 Dept No From: 5
Tran Date To: 31/08/2025 Dept No To: 5
Department Number 5 Department Name ICT Grant 2025
N/C N/C Name Debits Credits Balance
1461 Capital: ICT Additions 15,000.00 15,000.00
1800 Current Account 1 7,320.00 7,320.00
a7 Other Non Capital Ringfenced Income Unspent
2320 Other Loan
3921 DE ICT Grant Capital Income 22,500.00 -22,500.00
4410 Non Capital Computers / ICT Expense 180.00 180.00
Total for Dept. S 22,500.00 22,500.00
Grand Total: 22,500.00 22,500.00

From the report above the unspent amount of the ICT Grant in this example is €7,320.

If a Profit & Loss Report or Balance sheet report by department is required, Sage have
resources to help users access and use excel based reports for this purpose on their
website.
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4.8 Sage 50 Department reporting using
Microsoft Excel report library

Sage 50 Accounts Excel Report Library is a resource hosted by Sage to help users access
and use Excel-based reports tailored for Sage 50 Accounts.

Here's a summary of what the Excel Report Library offers:

The Excel Report Library is a collection of downloadable Excel templates that integrate with
Sage 50 Accounts to provide enhanced reporting capabilities. These reports are designed to
extend the built-in reporting features of Sage 50.

Types of Reports Available

The library includes reports across various categories, such as:
= Nominal Reports - e.g., trial balance, profit & loss, balance sheet.
= Departmental Reports — breakdowns by department if enabled.

= Purchase Reports - e.g., supplier balances, aged creditors, purchase analysis.
The reports which will provide a Profit & Loss By department are available at this link.

On the following screenshot of the available reports, the reports relevant to schools would be
the Balance Sheet & Budget V Actual (Standard Budget Method).

DOWNLOAD
Balance Sheet

You can enter a date range and Chart of accounts with options to display by
Month and or Department.

DOWNLOAD
Budget v Actuals (Advanced Budget Method) - Period
&YTD >

You have a current financial Period picker and Chart of accounts selection
with options to display by Period/YTD and or Department.

DOWNLOAD
Budget v Actuals (Standard Budget Method) - Period
&YTD >

You have a current financial Period picker and Chart of accounts selection
with options to display by Period/YTD and or Department.
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How to use the Reports: Summary

1.

o o w N

Download the Excel template from this link by clicking on the relevant report.
Open the file in Excel.

Connect it to your Sage 50 Accounts data using the Sage Excel Integration tools.
Refresh the data to pull in the latest figures.

Customize filters, formatting, and formulas as needed

Review reports for accuracy

Save and run the Department P&L Report Budget V Actual (Standard
Budget) Period V Actual

1.

Download the Excel workbook from the Sage report library, e.g. P&L Budget V Actual
(Standard Budget Method) Period & Year to date

Open the Microsoft Excel file
If the workbook opens in protected mode, see here

Click Enable Content.

Chart of accounts Default Layout of Accounts

Period from 01/09/2025

Perid to 31/08/2026) Wiz Connections
Start of Year 01/09/2025

Include B/fwd No|
Exclude Ledger Year End? Yes]

Departments (All) z|
Gross/Net Profit Category B sub-category N/C
-11-Gross Profit =01 - Sales =001 - Department Income 3010 - Capitation/Non Pay Budge

3050 - Ancillary/School Support S|
3130 - Caretaker Grant

Click the connections button to open the connections window

Follow the steps below: Summary
Connect workbook to Sage data
Select appropriate version of Sage
Select Archive only if required
Click get Company list

Select appropriate school data set

Enter Sage username (e.g. Manager)

N o o~ wnNn s

Enter password
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Excel Report Design - Connections

Steps to connect to the sage data for the first time or when an update to the PC has occurred.

1)  Connect to sage data ChnnRCE ROk | B Done

2) Select Sage version | Sage Line 50 v32 —v_l Fo

3)  Demodata or Archives [¥ Incude Demodata [~ Include Archives

4) Update company list Get Company List | F o

5)  Select company name | 11 - FSSU Demo data Aug 25 _v_l
6) Enter Sage user name I manager

7) Enter Sage user password = ¥ Save Pass

Company Datapath | C:\PROGRAMDATA\SAGE\ACCOUNTS\2026\COMPANY.002\Accdata
Report Name | Profit and Loss (Period and YTD)
[~ Show Progress Report Reference I 4

8) Refresh connections Refresh Close

8. Refresh connections: Click Refresh

Enter your report date and department criteria, then click Update.

Chart of accounts Default Layout of Accounts

Period from 01/09/2025

Perid to 31/08/2026 Update Connections
Start of Year 01/09/2025

lude B/fwd Noj
Ledger Year End? Yes]
Departments (All)
0 et Pro Bl catego = atego =
='1-Gross Profi =01- Sales =001 - Department Income 3010 - Capitation/Non Pay Budge|

3050 - Ancillary/School Support S|
3130 - Caretaker Grant

9. Customize filters, formatting, and formulas as needed.

10. Review the reports for accuracy and completeness in line with standard FSSU
accounts review guidance.
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5.1 Introduction

This section covers how to record supplier invoices and credit notes and their effect on the
purchase and nominal ledgers. The Supplier module is used to record information about
suppliers, such as contact details, credit facilities and invoices received and paid for. A
supplier can be either a company or a person you purchase goods and services from. In
addition, payments in full, part payments, allocating credit notes, paying on account and
printing remittance advices will also be covered. If you are using the Supplier module in TAS
(or relevant prior accounting system) please contact the FSSU for details to set up the
suppliers in Sage 50.



FSSU SAGE Accounts Manual Section 5: Supplier Module

5.2 Creating a New Supplier

Supplier record wizard

When setting up supplier records, you need to collect a lot of information. Using this wizard
helps you record everything that’s required. The Supplier record wizard captures key details
for a supplier which are added to a unique record. After completing the wizard take a look at
the record which includes other settings you may find useful.

To open the wizard » Suppliers » New/edit » Wizard.

MNew Supplier l _EZ_ |
Supplier Information
8 Supplier Details Supplier Details 9

To create a new supplier account you need to enter the supplier's name and a unique
reference,

o Contact Details

o Supplier Defauls MName* | New Supplier Account
R .
° Credit Details

Please enter the supplier's address.

o Bank Address Strasti

Street2

Town
o Bank Account County
Post Code

o Opening Balancz
Country Ireland E v

Cancel Back

Supplier's
Trading Name

A unique reference code used to identify the supplier. It can include letters
or numbers or both, for example SMITHO1, but you can't change this once
you save the record.

A/C Ref*

Your suppliers are listed in the Suppliers window and by default they're
sorted by this code.

As you begin typing text in the Name box, a reference code is suggested
for you. You can change this reference code if you want.

Address

Use the Street1, Street2, Town, County and Post Code lines to enter your
supplier's address.

The address is used in documents you may want to print and send to your
supplier such as invoices and letters.

Country

The suggested country is based on your regional settings in Windows.
From the drop-down list choose the country where the supplier is based.
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Telephone

number

Fax Record a fax number.

Emaill The email address you expect to use most often when emailing this
supplier.

Website The supplier’'s website.

Contact Name

The person responsible for the account, though you can use this box to
hold any other related information.

Trade Contact The person you contact if you have a query about an order.

VAT Number If you're VAT registered, enter the VAT Registration Number for this
supplier.

Accounts Select the status that applies to this account. When creating an account,

Status the status Open is used by default.

Nominal Code

This is the nominal account you expect to use most often for any purchase
transactions with this supplier.

When you record an invoice, credit or purchase order this nominal code
appears, although you can change it at that point.

Credit Limit

The amount of credit given to you by your supplier. Once you exceed the
limit, warnings appear when you work with the account.

Settlement Due
Days

If the supplier gives you a discount for early payment, enter the number of
days you have to pay within to qualify for the discount.

Payment Due
Days

Enter the number of days in which payment is due for outstanding
invoices.
If a payment is not made during this time, the invoice is flagged as
overdue.

Terms Enter the terms agreed with the supplier.

A/C Opened The date the supplier account was opened. This information can show you
how long the supplier has been trading with you.

Next Credit The date your credit terms with the supplier are due for review.

Review

Bank Name The name of the supplier’s bank.

Address The supplier’'s bank address.

Account Name

The name of the supplier’s bank account, for example J Smith & Sons.

Sort Code

The supplier’'s bank’s sort code.If you intend to make electronic payments
to the supplier, using E-banking, you must enter the supplier’s bank sort
code.
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Account No The supplier's bank account number. If you intend to make electronic
payments to the supplier using e-Banking, you must enter the supplier’'s
bank account number.

BACS/SEPA Enter the BACS/SEPA reference here.

Ref This is used for making e-Banking payments.
Online If you intend to pay this supplier using e-Banking, select this check box.
Payments
IBAN If required, enter the supplier’s International Bank Account Number
(IBAN).
An IBAN is always used in conjunction with a Bank Identifier Code (BIC).
BIC/Swift If required, enter the BIC number or SWIFT code for this supplier’s bank

account. The BIC or SWIFT code is a standard identifier for banks and
should be used for all international payments.

This number is validated when you enter it in the record.

Additional Ref Use this box to enter any additional information you have received about
this supplier’s bank account.

Payment From the drop-down list, choose the preferred payment method agreed
Method with this supplier.

Several payment methods are available as follows: BACS/SEPA, Cash,
Cheque, Credit Card, Direct Debit (DD) or Standing Order (SO) and Other.
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5.3 Setting the processing date

When you're processing in Sage 50 Accounts the date you use on every transaction is of
critical importance to the accuracy of your data. By default, Sage 50 Accounts uses the date
from Windows as its default date, that is, today's date.

If you want to change the default processing date, you can do this in:

Settings » Change Program Date

Change Program Date X
© Help

Enter a new date to be used as the default for transactions.
This date can be changed at time of posting.

Default Program Date = ERYBNUPAFE)

OK Cancel
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5.4 Supplier Invoice & Credit Notes

To keep track of what you owe to your suppliers you need to record all invoices and credits
you receive. Batch invoicing is a quick, simple procedure where you can enter purchases from
your suppliers line by line.

1. Suppliers » Batch invoice.

2. Foreach invoice item, or whole invoice, enter the details one line at a time.

~ - Tip:
—'~ Toinsertaline, use function key F7 or to delete a line use F8.

A/C* Enter the account reference of the required supplier or choose it from
the drop-down list. To create a new supplier record, from the drop-
down list, click New.

Date* The current software date appears automatically. If you want to
change this, either enter the new date or use the calendar button.

If you have lots of invoices to enter, all with the same date, in Settings
» Change Program Date you can set the software date to the date
you require.

Ref If required, you can enter a reference to help you trace your invoices
easily. Thisis the reference that appears on your reports.

Ex Ref If required, enter an additional reference here. For example, you could
enter the order number that the supplier has entered on the invoice.

N/C* Choose the nominal ledger account code to post the net value of the
invoice to.

The supplier’s default nominal code appears automatically. If you
want to change this, choose a new code from the drop-down list or
manually enter it.

Department - To assign this transaction to a specific department, enter a
department number.

Details You can enter up to 60 characters of text to identify the invoice entry.
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I Batch Supplier Invoice

A/C | Doherty Book Suppliers

2 B %

Clear Insert Remove Copy cell

N/C | Free schoolbook grant expense

DOHO01 ° 31/10/2025

Copy cell above Calculate Payin  Memorise Recall Print list Send to
form  row (F7) row (FB) above (F6) +1 (Shift+F6) net(F) full (F3) Excel

etails Net VAT Gross|Disp
30/11/2025 4731 8 Books. 3700.00 v 0.00 3700.00

E D 0 & @

Net|T/C

3700.00 0.00 3700.00

==

3. Save » Close.

Supplier credit note posting

1. Suppliers » Batch credit.

2. For each credit item, or whole credit, enter the credit details one line at a time.

A/C*

Enter the account reference of the required supplier or choose it from the
drop-down list. To create a new supplier record, from the drop-down list,
click New.

Date*

The current software date appears automatically. If you want to change this,
either enter the new date or use the calendar button.

If you have lots of invoices to enter, all with the same date, in Settings »
Change Program Date you can set the software date to the date you
require.

Credit No

If required, you can enter areference to help you trace your credit notes
easily. Thisis the reference that appears on your reports.

Ex. Ref

If required, enter an additional reference here.

N/C*

Choose the nominal ledger account code to post the net value of the credit
to.

The supplier's default nominal code appears automatically. If you want to
change this, choose a new code from the drop-down list or manually enter
it.

Department*

To assign this transaction to a specific department, enter a department
number.
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Fund If your company has a charitable status and you've created fund records,
you can associate the credit with an existing fund.

From the drop-down list choose the required fund.

Details You can enter up to 60 characters of text to identify the credit entry.

Net* Enterthe netvalue of the credit. If you prefer, you can enter the gross
amount, including VAT, and then click Calculate net (F9). The value is then
splitbetween netand VAT using the tax rate applied to the tax code.

T/C* The default tax code for this supplier automatically appears.
If you want, you can enter any of the other tax codes defined in your VAT
ratetable.

VAT* Displays the amount of VAT calculated by applying the tax code entered to

the netamount. If required, you can change this value.

3. Save » Close.
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5.5 Add attachments to supplier invoice or credit
transactions

Summary

How to add attachments to supplier invoices and credit note transactions in Sage 50 Accounts.

Description

Cut down on paperwork in a couple of clicks. If you have documents related to supplier invoices
or credits in Sage 50 Accounts v26.3 and above, you can add them as attachments for easy, quick
reference. Let's do this now.

To back up your attachments

What can | attach?

You can attach any of the following file types:

BMP PNG
CSv RTF
DOCX TXT
DOCM XLSX
DOC XLSM
JPG XLSB
JPEG XLS
ODS XLA
OoDT XML
PDF XPS

j Note: Attachments can be up to bmb in size.

[B Batch Supplier Invoice

= = = = e - =
Il 9 7 LY =
Clear  Insert Remove Copycell Copycel above Calaate Memorise Recall  Printlist Send to
form | row (F7) row (F8) above (F6) +1(Shift +F6) net (F9) Excel

Alc [ suppler 1
NJC [ Materials Purchased

|ajc= |Attach  |Date* |Due On* |Ref  |Ex.Ref [N/C*  |Department®|ProjectRef |CostCode |Details |

SUPP1 e 09/02/2022  |11/03/2022 5000 0 0.00 T1 0.00 0.00 | /]
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To add an attachment as you post the transaction

Follow the steps:

1. Click Suppliers, then click Batch invoice or Batch credit as required.

Enter your batch invoice or credit as normal, but in the Attachment column, click the ‘+'
icon.

Depending upon your access rights, you may either drag and drop your attachments into
the Add New Attachment window, or click Browse to browse your attachment(s) in.

Add Mew Attachment >

Use this feature to attach any relevant, supporting documents {maximum file size SME). 9
Files attached will be a copy of the ariginal document.

Attachments added to consecutive transactions with the same AJC, Date and Ref are
grouped together under the first transaction.

Add attachment

Drag and drop your files here

or dick

Browse

Path and filename

Remaove

oK I | Cancel

1. Once you've finished adding attachments, click OK, then click Save.

~‘— Tip: Attachments are created as copies of the original documents and are
" stored in the Transaction Attachments folder for the relevant company.
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To view an attachment

In Supplier Activity
1. Click Suppliers, select the required supplier, then click Activity.

2. Toview an attachment click the paperclip icon £ on the relevant transaction line.

In the Audit Trail report
1. Click Transactions, then click Reports.
2. Select Audit trail and then click the Audit Trail (Detailed, Landscape) report.
3. Click Preview and then enter the relevant Criteria Values.

4, Click the link for the relevant transaction to view the associated attachment.

-.', Supplier Record - Supplier 1 - O
B o O B E E & ® '
% B & al i ) S B ig E1;
Clear New | Delete Skype Google View Edit Delete View View bank = Hide Printlist Send to
form | order Maps transaction ftransaction transaction = item charges | detail Excel
Details AlC SUPP1 Balance :
Defaults
Name [Supplier 1 | Amount Paid
Credit Control
Bank Credit Limit Turnover YTD
Alerts Show: | All Transactions A4 Date: ‘0110111980fﬂ3111212999 ‘ Type: ‘A" ‘ ofsonly [] Trans.:| 1to 202
Communications
Memo No 4 |Type  |Date |DueOn  [Ref |Details | Amount| afs| | Debit|
84 PI 01/08/2019 31/08/2013 120.00
85 PA 27f07/2019 Payment on Account 120.00 120.00
112 PP 17/12/2019 Purchase Payment 120.00 120.00
Purchases 20/01/2020 19/02/2020 1
Orders 20/01/2020 Purchase Payment
Graph -
No|Type [Date |Ref  |N/C | Dept|ExRef |Details |Project Ref |CostCode|Tax| Amount| Debit| Credit| Trans.B
E20z2pr1  09/02/2022 5000 0 T

ﬂ Note: Attachments can’t be viewed in Company Archives

¢ TABLE OF CONTENTS 119



FSSU SAGE Accounts Manual Section 5: Supplier Module

To add further attachments to a transaction
1. Click Suppliers, select the required supplier, then click Activity.
2. Locate the transaction you want to add the attachment to then click the +' icon.

3. Depending upon your access rights, you may either drag and drop your attachments into
the Add New Attachment window, or to browse to your attachments, click Browse.

4. Once you've finished adding attachments, click OK, then click Close.

€y Activity - O

@ =: Add Mew Attachment X

View Edit
fransaction transaction | Use this feature to attach any relevant, supporting documents (maximum file size SME). 9

AfC SUPP1 Files attached will be a copy of the original document. 10|
Name Suppll  Attached documents PE 370
BP £ 300)

Credit Limit GBP £
Ins.:| 1to 202

Debit £  Credit £

120.00

Show: | All Transactions

120.00
120.00

10.004

Add attachment 10.00

Drag and drop your files here

or dick /
=

Path and filename Remove

I: oK | | Cancel
Record 1of 1 @




FSSU SAGE Accounts Manual Section 5: Supplier Module

To delete an attachment
1. Click Suppliers, select the required supplier, then click Activity.
2. Locate the transaction you want to delete the attachment from then click the '+ icon.

3. Click the B icon for the attachment you want to delete. Click OK, then click Close

€ Activit - m]

@ Ejl Add New Attachment X
View Edit
transaction transaction Use this feature to attach any relevant, supporting documents (maximum file size SMB). 9

AjC SUPP] Files attached will be a copy of the original document.
Name Suppli  Attached documents PE 3
Credit Limit GBP £ D |

Show: | All Transactions

Add attachment

Drag and drop your files here
or dlick

Browse

Path and filename

Record 10f 1

To back up your attachments

When you back up your data, if you want to back up your attachments, click File, then click Back up
and ensure the Transaction attachments check box is selected, then click OK. You can only back up
attachments if the Data file check box is also selected.
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5.6 Supplier Payments

To help you maintain good working relationships with your suppliers it's important that you
pay your invoices on time. The Supplier Payments window helps you easily allocate your
payments to the relevant invoices.

You can see what the oldest outstanding invoices are so that you can clear these invoices first
or you can even spread the payment value over multiple invoices.

To record a supplier payment

2. Bank accounts » Payments drop-down » Supplier payment.

L o\ m®

form  full (F3)

Bank Details

Bank A/C 1800 v

Balance 18510.00

how Al

1% Supplier Payment - Current Account 1

[lear Payin Wizard Automatic Department Print list Send to

Name Current Account 1

© tep)

¥ o=

Excel

Supplier Details Payment Details

Account™ DOHo01 b Date™ 31/10/2025
Reference
Balance 0.00 Ex. Reference

Amount 3700.00 =

Analysis Total 3700.00

save || Close

Complete the Supplier Payment window as follows:

Bank A/C Ref Choose the required bank account.

Payee Choose the required supplier account.

Date Enter the date of the payment.

Cheque No. Enter the cheque number or reference for the payment.
Note: If you use e-Banking and pay this supplier with online payments, the
reference automatically appears as BACS, you should not change this.

Amount box Enter the amount of the payment.

Show

- Due - Only shows transactions within their due date. You setthe due date

- Date Range - If you choose this option you can then enter the From and To

Tofilter which transactions appear in this window, from the drop-down list
choose one of the following:
- All-Shows all transactions.

within Suppliers 3 Supplier Record > Credit Control 3 Payment Due. This
then records on each transaction.

date which then only shows transactions in this date range.
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List Invoice/ To see the individual lines for invoices which have been grouped, select this
Credit by item check box.

line

Payment Enter the required payment value against the relevant invoices.

To allocate credit notes or payments on account, enter the value you want to
allocate on the credit note or payment on account item line then enter the same
value ontheinvoice itemline.
Tip: If your invoices have been fully paid you can use the Pay in Full option
which automatically enters the full value of the invoice. Or press F3

Discount Inthe Discount column enter any required discount value against the relevant
invoice. You must also reduce the payment value by the discount value.

3. Save » Close.
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5.7 Supplier Remittance Advices

Remittance advices

To enable this option, ensure a tick is placed to Always Create Remittance from
Settings » Bank Defaults

Bank Defaults X
© telp
General
[Jenable e-Banking [CINo Warning on Visa receipts
[CIGroup items in Bank Rec. [“]Group Bank Transactions

[CJList Invoice/Credit by item line  [¥] Always Create Remittance
[¥]Create Bank Reconcilliation PDF

Payment defaults
Std Tax T9 0.00 v Def. N/C v

Department* 0 v  Default

Receipt defaults
Std Tax T9 0.00 v Def. N/C v

Department* 0 v  Default

Cash register settings

Bank A/C: v
Sales v Discrepancies: v
Tax code: T9 0.00 v [JTakings are VAT indusive

[ o ][ st |
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Itis possible to print remittances Bank Accounts » Remittances

E‘, Remittance

=23

%

0O = &

Swap Clear Purge Delete Printlist Send to
Excel
Bank 1800 v Current Account 1
Print
. Snow printea
[Ipate Range From: Seiess
To:

Cheque Supplier A

DOHO01

ty Book

O

r Name

Suppliers

d? | Rems|Email or Prin
1 Print

| Print Remittances ” Close |

Select the supplier(s) you want to print remittances for by highlighting them on the list.

E: Remittance |':' = = |
¥ —
= X
DE 0 8O
Swap Clear | Purge Delete | Printlist Send to
Excel
Bank | 1800 v Current Account
Print
[IpateRange  From: | /[ = show printed items [
Tor § ' Remittance Advice Printing ‘ =B ®
Details Layout
Jescriptio |File Name Qutput
ml A4 Remittance Layout - Plain Paper (Print o... REMITPLAINAS.LAYOLT I
BB 01/04/2016 Remittance Layout - 117 REMIT11.layout Oprintes K
Remittance Layout - A4 REMITA4.layout i
Security Mailer Remittance SecMaiRem.layout (&) Preview
OFile
OEmail
ES
—_—
= =]

Click on the Create Remittance button and choose the required print format.

You can click show printed items if you need to reprint any.
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5.8 E-banking

E-banking enables you to:
Create payment files to upload to your bank in order to pay your suppliers

The bank account through which you wish to conduct e-banking must be connected to the
internet banking service. Sage supports Bank of Ireland and Allied Irish Banks.

Setting up e-banking
E-banking is not enabled automatically; the following steps must be completed:

Select Settings »» Bank Defaults and select Enable e-Banking.

Bank Defaults X
© e
General
[“Ienable e-Banking [CIno warning on Visa receipts
[JGroup items in Bank Rec. [“IGroup Bank Transactions

[uist Invoice/Credit by item line  [¥]Always Create Remittance
[“I Create Bank Reconcilliation POF [] Always create batch e-payments

Payment defaults
Std Tax T9 0.00 v Def. N/C v

Department® 0 v  Default

Receipt defaults
Std Tax T9 0.00 v Def. N/C v

Department* 0 v  Default

Cash register settings

Bank A/C: v
Sales v Discrepancies: v
Tax code: T9 0.00 M [JTakings are VAT indusive

o] [om ]
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Select the required bank from the Bank Details tab select Bank Type

1 Bank Record-Current Account 1 — o X
© elp
Bank Address Account Details
Bank Name Account Name
Account Numbe:
Street1 (r3 s
Street2 Sort Code Bpiry [/
Actwity T BACS/SEPA Ref
County
Post Code -
BIC/Swift Lookup |
Cuenct Roll Number
Teleph
- Additional Ref
Fax
Email =]
Website =] Electronic Banking
Bank Type: 0 Not Selected v
Save Close

Click the configure button to configure the settings

You can specify a common directory to store Supplier Payments Files.
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5.9 Supplier Activity Record

This is a great way to view the history of trading between you and your supplier. It shows
your credit limit with them, the balance owed as well as the total amount you've paid and the
expenditure for the year.

A summary of dealings you've had with the supplier appear in a list. Each line in the list
represents a transaction such as an invoice or payment.

To view the activity » Suppliers > double-click the required record > Activity

€5 Activity - 0o X
© tielp
= . - -
B B B B g B ® = @
View Edit Unallocate  Delete View View bank Hide Print list Send to
tr item charges detail Excel

A/C v Balance EUR € 0.00
Name Doherty Book Suppliers Amount Paid EUR € 3700.00
Credit Limit EUR € 0.00 Turnover YTD EUR € 0.00
Show: All Transactions v Date: | 01/01/1980 to 31/12/2099 Type: Al 0/S Only [J Trans. 1to15

Due O
© 14 PI 31/10/2025 30/11/2025 Books 3700.00 3700.00
Purchase Payment 3700.00 3700.00

f Details Tax( Amount € Debit€| Credit€

15 PP 31/10/2025 ) Purchase Payment T9 3700.00 3700.00

31/10/2025 0 3700.00 to PI 14
Future € Current € 30 Days € 60 Days € 90 Days € Older €
0.00 0.00 0.00 0.00 0.00 0.00
Record 1 of 1 ‘ Close ]

= To filter the transactions which appear, from the Show drop-down list, choose the criteria
you require.

= Ifyou choose Custom Range, a further window appears where you can define a
transaction number range, date range and transaction type. The selections you make here
are shown in the boxes alongside the Show drop-down list.

= Inthe toolbar, you can click the Show detail and Hide detail buttons. Show detail opens a
window breaking down any selected transaction into its component parts. For example,
a purchase payment is broken down into the invoices it paid off, where as a purchase
invoice lists any payments allocated against it. Hide detail closes the window showing the
detailed breakdown.
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5.10Supplier Aged Balances

Seeing a supplier’s outstanding balances, grouped by the age of the credit, is a useful way of
keeping track of what you owe that supplier and can act as a useful reminder to pay. You can
use the Aged balances option to help you organise required payments and ease your cash
flow.

When you analyse your aged balances, you can enter a date for the report, and you can also
include payments up to a particular date, so you can run the report retrospectively.

To analyse aged balances for suppliers
1. Suppliers » select the required suppliers.
2. Aged balances » enter the dates you require.

The Aged Balances window appears showing each selected supplier. The total of any
outstanding values are grouped by age. The age period is determined by the setting in the
Settings » Supplier Defaults » Ageing. It is either based on calendar months, or is based
on a period of days that you can specify.

The total amount you owe all of the selected suppliers is also shown, grouped by age, in
the total boxes at the bottom of the window.

3. To see the balances in a graphical format >» Graph.

4. To see the individual transactions that make up a supplier’s aged balances » Aged
Balances » select the supplier from the list » Detailed view.

5. Ifthe invoice was created from a purchase order, to view the order » select the required
transaction » View item.

6. To return to the Suppliers window » Close » Close.

Date: 06/11/2025 FSSU Master Chart of accounts New Page: 1
Time: 17:07:58 Aged Creditors Analysis (Summary)

Report Date: 31/10/2025 Supplier From: DOH001
Include future transactions: No Supplier To: DOHO001

Exclude Later Payments: No

** NOTE: All report values are shown in Base Currency, unless otherwise indicated **

AlC Name Credit Limit Tumover Balance Future Current  Period1  Period2  Period 3 Older

DOHO01  Doherty Book Suppliers € 0.00  5600.00 5,600.00 0.00 0.00 0.00  5,600.00 0.00 0.00

Totals: SE00.00  5600.00 0.00 0.00 000 5600.00 0.00 0.00
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5.11Suppliers Payment Allocation

Itis important to maintain a clean supplier list and ensure that all payments are allocated
against specific invoices. Periodically review the ledger and check for any unallocated
payments or credit notes and allocate against the relevant invoices.

J! Aged Balances as of 28th November 2025

Q & @ B

petailed Print list Sendto Reports
Excel

Aged Balance report date  28/11/2025

© Help

Include Payments Up To

28/11/2025

Future Current 30 Days 60 Days 90 Days Older Balance Creditors
0.00 -1000.00 0.00 5600.00 0.00 0.00 4600.00 4600.00
.
Supplier payments can be allocated as follows:
.
B Sage 50 Accounts Client Manager - FSSU Master Chart of accounts New Dataset 2024 2025
Fle Edt View Modules Settings Connected services  Tools Favourites Weblinks  Software updates  Help
Home
[) = == s o3 Refund =l
Apps and add-ons &S ©« B B B\ :0“99‘;:”’"‘"" e’ = = & (X
Business dashboard  yey/edit Activity AlDocument Batch Batch Supplier JAged 1 - Swap Printlist Sendto Labels Letters
- Capture  invoice credif\ pa t Jalances {3 Contra entries Excel
Customers
Invoices and credits o
7% Supplier Payment - Current Account 1
Il 9N =2 & o &
Products and services | Clear Payin Wizard Automatic Department Print list Send to
form  full (F3) Excel
Bank accounts
Bank feeds
Bank Details Supplier Details Payment Details
Nominal codes
1800 v DOHO01 v - 28/11/2025
Tra Bank A/C Account™® Date /11/
Name Current Account 1 Name Doherty Book Suppliers b
ety Balance 18010.00 Balance 4600.00 Ex. Reference
Diary Amount
Show Al v Fro To
—
Date Due on Payment Di
16 P1  DOHO01 31/08/2025 30/09/2025 n/a n/a | 5600.00 1000.00 0.00
25/PA  DOHOO1 28/11/2025 n/a Payment o... n/a 100000 1000.00 0.00

1. Click on Supplier payment

2. Select appropriate Bank account

CO TABLE OF CONTENTS
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N o o M w

Select Account (supplier) and enter Date.

Leave Amount at 0.00 (Sage will prompt allocation).

For full payment: Click into Payment box and click Pay in Full.

For partial payment: Click into Payment box, enter amount, press TAB.

Click Save, then Close.

Allocate Credit Notes

1.

2
3
4,
5

Click on supplier payment

Enter Account and Date; leave Amount blank.

Click into Payment box and click Pay in Full for credit/payment and invoice.
For partial: enter amounts in Payment column.

Click Save, then Close.

Combine Credit/Payment and Invoice Allocations

1.

2
3
4,
5

Click on Supplier payment
Fill Account, Date, and amount paid or nil if matching amounts.
Click into Payment box and click Pay in Full for credits and invoices.

Ensure Analysis Total reflects full applied value.
Click Save, then Close.
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5.12Supplier Reports

As part of the month end procedures the following reports should be printed and filed on
a Supplier Report file. The reports are stored as favourite’s in Sage.

1. Daybooks: Supplier invoices detailed

Daybooks: Supplier Credit detailed

Daybooks: Supplier Payments- print from the Bank Module
Aged Creditors detailed

o 0N

Aged Creditors Summary

To print or preview a report, select it and click Print or Preview, then enter the criteria for the
report if appropriate.

Use the criteria to select the range of information that you want in your report;

upplier reports

ﬁ@m@‘%@ﬁ%m

Delete Preview Print Export Excel Email e . N

rommes
B Add the documents that you use most often to Favourites to access and generate
Aged areditors are added and removed by clicking the staricon. You can drag and drop your favi
Credit control Criteri ! N 1 IEEh
riteria for Day Books: Supplier Invoices [Detailed)
Daily transactions
Day books Criteria Values
Departmental Enter the » r the criteria in this report
EC purchases
My sinplier rocts Transaction Date Between inclusive) + | 01/01/1980 + and 31/12/2019 -
Supplier activity T ion No IBHWEE"* linclusive) ‘“1 Ejl and |38898883 )::'.ﬂ
Supplier contacts Department [Between fnciusive) [0 [ and [398 =)
SErDlETiesE Nominal Code Between fnclusive) _+ ~ and 99593389 -
Supplier invoices ;
P — Preview a sample report for a specified number of records or transactions (Dforall) [0 =
Top suppliers
03
supplier.
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Customer Module (Used by Fee Charging Schools /
Non-Fee Paying Schools with rental income)

6.1 Introduction

The sales ledger or customer ledger, as it is sometimes known, is very similar in operation and
features to the supplier ledger. The customer’s module in SAGE 50 accounts is used to record
information about customers (students) such as contact details, invoices sent and paid for. If
you are using the Sales Ledger in TAS (or relevant prior accounting system) please contact
the FSSU for details to set up the customers in SAGE 50.
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6.2 Creating a

Section 6: Customer Module

New Customer

You can use the Customer record wizard to enter customer details in a series of steps. The
wizard helps to ensure you enter all of the required information quickly and correctly. Entering
full customer details in the record saves you time when processing transactions.

You can access the wizard through Customers » New/edit drop-down » Wizard

MNew Customer

1

o Contact Details

° Credit Details
o Bank Address
o Bank Account
o Opening Balance

Customer Information

Customer Details

o Customer Defaults

Customer Details

To create a new customer account you need to enter the customer's name and
a unigue reference,

Name™ | New Customer Account |

[ 1

Please enter the customer's address,

AJC Ref*

Streetl
Street2
Town
County
Post Code

Country Ireland

Cancel

Mext

Name* The customer’s (students) name. This is used in reports and documents
you can printand send to your customer, for example, invoices.
A/C Ref* A unique reference code for the customer. It can include letters or

numbers or both, for example SMITHO1, but you can't change this once
you save the record.
Your customers are listed in the Customers window and by default they
are sorted by this code.
Tip: When using numeric codes make sure you use leading zeros in the
number. This keeps the code sorted in the correct order.

As you begin typing text in the Name box, a reference code is suggested
for you. You can change this reference code if you want.

Address lines

Thisis used in documents you can printand send to your customer such
asinvoices, credit notes, letters, labels and statements.

Tip: You can change the labels used for the address lines to suit your
needs in Settings » Company Preferences » Labels.

* This information is mandatory.

Contact Details
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Telephone The number you expect to use most often when contacting this customer.

Fax Record a fax or telex number.

Email 1 The email address you expect to use most often when emailing this
customer.
Tip: When the customer’s record is open, you can generate an email
based on this address.

Website The customer’s website address.

Tip: When the customer’s record is open you can access their website,
provided you are connected to the Internet.

Contact Name

The person responsible for the account, though you can use this box to
hold any other related information.

Account Status

Select the status that applies to this account. When creating an account,
the status Open is the default.

Customer Defaults

Nominal Code

This is the nominal account you expect to use most often to post the net
value of any sales transactions when dealing with the customer.

When you record an invoice, credit or sales order the nominal code
appears but you can change it if required. The code is also displayed when
you record a credit note for the customer.

The nominal code you want to use for net sales from the drop-down list.

The code that appears is taken from your Customer Defaults.

Use Default
Nominal Code
for Sales

When creating an invoice or sales order and selecting a product, the
nominal account suggested for your net sales posting comes from the
default on the product record.

If you prefer to categorise your sales by customer, for example, if you have
a set of nominal codes for sales to customers in different regions, select
this check box.

Use Default Tax
Code for Sales

Select this check box if you want to use your default sales tax code.
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6.3 Setting the processing date

When you're processing in Sage 50 Accounts the date you use on every transaction is of
critical importance to the accuracy of your data. By default, Sage 50 Accounts uses the date
from Windows as its default date, that is, today's date.

If you want to change the default processing date, you can do this in:

Settings » Change Program Date

Change Program Date

Default Program Date

31/10/2025

Enter a new date to be used as the default for transactions.
This date can be changed at time of posting.

X

© Help

oK

Cancel

Customer Default

The terms agreed with the customer must be entered before processing invoices. If customer
terms are not required please tick the box in Customer defauls for terms Agreed.

Settings » Customer Defaults

Customer Defaults |_§:§_ |
Record Statements | Ageing Discount
Defaults
Country |Ire|ar1d IE w |
Currency |3 Eura |
Std Tax Code T9 0.00 W Def. NjC
Department™® Default
Discounts
Discount % Type Mo additional vl
Price List | v
Account status
Default |U Open w |
Terms Agreed
oK | | Cancel
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6.4 Customer Invoices & Credit Notes

Processing Invoices not created in Sage
Batch invoices and credit notes

Schools may have created the School Fee invoices/credit notes using Excel or Word or other
software for billing. The school can enter these invoices/credit notes using the batch invoice
and credit functions. Using the batch method will allow the school to enter the fee invoice/
credit note against the relevant customer.

This can be accessed from Customers by clicking Batch invoice or Batch credit.

%S < BEE\E | * &
o >/ \ Les )
Mew Wizard Ach'vity\ Batch Batch ustomer Disputes Price lists
invoice  credit / receipt
N\ 2
Eﬂatch Customer Invoice El= B
—= — L — = —
l=e = 5 &® 2 E
Clear Insert Remove Copycel Copycellabove Calculate  Memorise Recall | Printlist Send to
form | row (F7) row (FB) above (F&) +1(Shift +F6) net(F3) Excel
AfC | Tax Rate 0.00
NfC Total 4000.00
J Department™ |Details
IMB 01/09/2016 0001 | 13300 o .1016,"2017 4000.00 T9 | 0.00

Creating Invoices and Credits Notes in Sage

The invoices and credits module allows you to create and produce a printed document for
invoices and credit notes as well as updating the sales ledger.

Invoice automatic numbering

Before using the invoices and credits module it is important to set the starting number for
invoices and credit notes.

Settings » Invoice & Order Defaults » Options tab

Invoice and Order Defaults |_§E__
Discounts | Intrastat | Cash Sales Lick Print Email
General | Footer Defaults Update ledgers
Invoice and Order Numbering
Credits start from
Sales orders start from
L ke = = 4

This enables the system to continue with the numbering sequence used in creating the
invoice

To ensure that you do not overwrite the automatically assigned numbers the system can lock
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the auto numbering under the General tab. To assign your own invoice/credit numbers do not

lock the numbering.

Creating an Invoice

B B

= e

Mew  Mew Recurring Update Quick print  Print  Email
invoice credit items  ledgers
(Y[ Fiter || | All records (0)

1. Invoicing and credits » New invoice.

2. From the relevant drop-down lists, choose the type and format of the invoice you require,
for example, to create a product invoice, from the Type drop-down list choose Invoice and
from the Format drop down list choose Product.

3. Use the top part of the window to enter the main details about your invoice or credit.

4. Enterthe items, one line at a time. The product details automatically update into the
invoicing window from the product record.

a. Invoicing using Product Codes

Product Code*

Enter the product code for the invoice item. Choose the code from
the drop-down list or you can type directly into this box.

You can also select the special product codes from the product code
list. If you use the special product codes the Edit ltem Line window
appears automatically.

If you need to add service items to your product invoices there are
special product codes available.

Description

The description automatically updates with details from the product
record. You can change this if required.

If you want to enter any one-off product details, double-click the
Description box or press F3.

Quantity

Enter the quantity of the product here. The default is one unit of the
product.

If you have already entered a quantity on the Edit Item Line window, it
appears here,

Price

The unit price from the product record appears here. If a special
product code has been entered, the value entered in the Edit Item
Line window appears here. You can change these values if required.

Net

The netvalue calculates automatically and cannot be edited.

VAT

Vat Zero.

* This information is mandatory.
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Section 6: Customer Module

Invoice using Service Invoice

Invoices and credit notes are free-text based. This means you manually enter a
description for the services or goods.

Details* If you are creating a service invoice, use this text box to enter details of
the service provided

Amount Enter the price of the service provided.

Net The net value calculates automatically and cannot be edited.

VAT

* This information is mandatory.

The item line details can be edited further by pressing F3.

N ’

Tip:

v
|I|‘
"\

The following additional fields are available for each item line:

Units Product invoices only
Enter the unittype here, for example, you may sell items by the sheet
or roll. This is for reference only.
Details Service invoices only
Enter details of the service in this box if required. The details of the
service entered on the main invoice window appear here by default.
Comment 1 You can enter additional comments about the product item lines here.
and 2
Unit Price The sales price from the product record appears here, unless a

customer price listis in use.

Note: Price lists are only available in Sage 50 Accounts Plus and
Sage 50 Accounts Professional.

Discount %

The total discount percentage appears here. This can be changed but
any changes made here do not save back to the Customer Record. To
view a breakdown of how this discount is made up, click Discounts.

Information

Disc. This shows the value of the discount the customer will receive. The
currency reflects the currency on the customer record, if you have
activated Foreign Trader.

Nominal* This is the sales nominal code taken from either the Product Record
or the Customer Record. This depends on the selection of the Use
Default Nominal code for Sales check box in the customer record.

Tax Code The default tax code can be taken from a number of areas

Department This is the default department for the product.

Line Enter any additional information about the item line in this box.
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5. Click OK.

6. Toapply a net value discount, in the Deduction area at the bottom of the window, click
the drill-down button in the Description box then complete the Edit Item Line window as
follows:

a. Enter adescription for the discount of up to twenty five characters.
b. If required, you can enter further comments of up to sixty characters.

c. Enter either a discount percentage or a discount value into the appropriate box. The
corresponding discount amount or percentage appears.

7. Check the totals.

There are a number of other options at the foot of the invoice that you can complete as

required.
FI Service Invoice = a
© telp
— — -
I =2 2 5 K [ ) oo E 2
Clear Insert Remove Copycell Viewitem Payby Memorise Recall Quick Print Send to
form  row (F7) row (F8) above (F6) (F3) card print Excel
Order
(r3 Type Invoice v | Inv.No. <AutoNumber>
Payment Format Service Order No
Date™ 13/11/2025 Due On* ot
AC* @ ¥ | Rem No. Item 1 of 1

Customer Order

Hire of Hall 700.00 700.00 0.00

To set the nominal code for the service invoice click the arrow in the details line.
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The Description line will update your ledgers, whereas the Details will print on the

invoice.
= T
B¥ Service Invoice = () X
© Help
I 2B T  @IW & (TN - Bl
Clear Insert Remove cell Viewitem Payby Cash Memorise Recall Quick Print Send to
form row (F7) row (F8) above (F6) (F3) card sale print Excel
OFM Local Badminton Club 4 Type Invoice v | Inv.No. <AutoNumber>
Payment Format Service Order No
Date™ 07/11/2025 Due On*  07/12/2025
AC* @ LBCOO1 v Rem No. Item 1 of 1
Customer Order
|e hall 500.00 500.00 ) 0.00
Edit Item Line X ‘
© telp
Details ‘
Description Hire of hall
Details Hire of hall a
Order Reference Order Line Reference Total EUR € 500.00 0.00
Carriage EUR € 0.00 0.00
Values Gross EUR € 500.00
Qty/Hours 1.00 T Discount % 0.0000 = Net EUR € 500.00 Euro € 500.00
Unit Price EUR € 500.00 ¥ Disc. EUR € 0.00 = VATEURE 0.00 LessDepost EURE  [o] 0.00
Amount Due EUR € 500.00
Posting Details Negative fine |
| Nominal* 3350 v Make negotive o |[M oo
Tax Code T9 0.00 v
Department 0 v |Default
0 of 0 invoices selected, t
] Last Inv/Crd: O 07/11/2
Additional Information
sand
Line Information hal ledger
Calc. Net Discounts oK Cancel
Invoice Amendments
Clear form Clears the information you have entered so far.
Quick print Printa copy of the invoice instantly. This does not update the invoice
details to the ledgers.
Print Prints the invoice. You can choose from a list of invoice layouts and

agree to update the values to the customer record and nominal ledger
if required.

Send to Excel

Open the invoice details in Microsoft Excel.

Insert row (F7)

Inserts a blank line in the row above. You can use the function key F7
asashortcut.

Remove row
(F8)

Deletes the whole line of information. You can use the function key F8
as ashortcut.
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Copy cell above | Copiesinformation from the field above. You can use the function key
(F6) F6 as a shortcut.

View item (F3) | Opens the Edit Iltem Line window, displaying the information relating
to that particular item on the invoice or order. You can use the function

key F3 as ashortcut.
Navigation When you select to edit more than one record, you can use the arrows
arrows to easily navigate between them.
Close Closes the window.

8. When you have finished entering the details, to save the invoice or credit > Save.

Duplicating Invoices

When creating invoices with the same details and value it will save time to use the duplicate
feature to copy existing invoices to create new ones.

Select the invoice you want to duplicate from the list and click Duplicate from the invoices
and credits toolbar. A new invoice will appear. It is important that you check all details
before saving. Credit notes can also be duplicated.

[E Service Invoice - Duplicate of < 1 > - O X
© telp
[=—] [—] =

Il 22 9 M =2 3 oo E R
Clear Insert Remove Copycell Viewitem Payby Cash Memorise Recall Quick Print Send to
form row (F7) row (F8) above (F6) (F3) card  sale print Excel

Order -

R Local Badminton Club 4 Type Invoice v Inv.No.  <AutoNumber>
Payment Format Service Order No

Date™ 07/11/2025 Due On*  07/12/2025

NC* |© ¥ Rem No. Item 1 of 1

Customer Order

Hire of hall 500.00 500.00 0.00

Deduction z
Net Value Discount ° 0.00 Total EUR € 500.00 0.00
Carriage EUR € 0.00 0.00
Gross EUR € 500.00
Euro € 500.00

Less Deposit EUR € @ 0.00

Amount Due EUR € 500.00
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Printing Invoices

Invoices can be printed directly within the invoice screen prior to saving it or subsequently by
selecting the invoices from the invoices and credits module and clicking the Print button. If no
invoices are selected, you will be prompted to print all invoices.

Modules Settings  Connected services Tools Favourites WebLinks Software updates Help

P % R B % @[E

-
=0
New New Edit Duplicate ate te Recurring Update Credit Quick pring Print Zmail
Invoice credit items  ledgers invoice

I | Refresh I [?" Filter I All records (1)

Date Name

07/11/2025 Local Badminton Club 500.00

When using the Print button an invoice layout has to be selected each time. The layout that
that suits your school should be added to favourites for future use. With the Quick Print
button this is not necessary although the first time you use quick print, you will be asked to
select a default layout that will automatically be used in the future:

Favourites

Add the documents that you use most often to Favourites to access and generate them quickly. Documents are added and
removed by clicking the staricon. You can drag and drop your favourites into any order you want.

Name Description Last Run Filename

Designed to be emailed or printed

on plain paper. Indudes
* A4 Inv Settlement Discount - Plain Paper (Print or Email)  amounts ar t & é % ﬂ %
discount details. e sent

post or email,

Emailing Invoices

If you wish to email invoices to customers, ensure the customer’s email address is entered in
the Details tab of their record.

Email Settings & Addresses
Emailt | =|
Email2 | &= |
Email3 | = |
1 send letters, statements, etc, to this customer via email [
1 send invoices to this customer via Transaction Email ]

The first time you email an invoice, you will be prompted to select a default layout. It is
important to select an email layout to ensure the invoice is sent in full.

The list of Invoices will be updated to show that it was printed /emailed. Invoices can be
edited and changed before they are posted to the ledgers. They can also be re-printed at
any time.

Once the invoice is complete and sent to the customer the sales ledger should be updated.
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6.5 Updating Sales Ledger

Once the invoice is complete and has been sent or given to the customer, it should be updated
to the accounts.

From the Invoices and credits module select the invoice(s) to be posted and click Update

ledgers.
Modules Settings  Connected services Tools Favourites WebLinks Software updates Help
] - /7 =] -
5585 % B RV & @8=D
New New Edit Duplicate Recurrijg Update Qredit Quick print Print Email
invoice credit items \Iedgﬂi/gmm
S
==y —
o Type Date Name Amount
Srv 07/11/2025 Local Badminton Club 500.00

The update routine generates a report which will display any problems with the update such
as a missing nominal code.

Otherwise it will confirm the posting details:

The Posted column on the invoice list indicates whether the invoices have been updated or
not. Any invoices that have not been updated will have to be amended. They can then be taken
through the update routine again.

The program will not allow an invoice to be posted twice. If a copy of an invoice that has been
updated is reprinted, notes or messages can be added, but values posted to the accounts
cannot be changed.

Credit Notes

Creating and posting credit notes to customer accounts is exactly the same as for invoices.
When raising the credit note ensure the invoice Type is set to Credit.

Modules Settings  Connected services Tools Favourites  WebLinks Software updates Help
—
=/ = - = -
58 % B F %R & @ex 2
Ne New Ediy Duplicate Recurring Update Credit Quick print Print Email
invoica_ credit / items  ledgers invoice
; A records ()
No Type Dat Name Amount
1 Srv 07/11/2025 Local Badminton Club 500.00

There is also a Credit Invoice button, this allows you to highlight an existing invoice and create
a credit note with exactly the same details. When you save this credit note you will be given
the option to automatically update it and allocate to the invoice it was created from.

J——

~
™ =1/ 2 N\
o BB = @,’/’E \
New New Edit Duplicate Recurring Updale Credit | |

invoice credit items ledger\g\lnvooce |/
i ~
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[E» Service Credit from Invoice < 1 > — (m} X
© Help
= =
i 22 39 K F & ©e E 2
Insert Remove Copycell View item Memorise Quick Print Send to
row (F7) row (F8) above (F6)  (F3) print Excel
P e
Local Badminton Club T \_ | Credit /Crd.No.
i ul s we (C __B _/cr <AutoNumber>
Format Service Order No
Date™ Due On*  11/11/2025
AC* O LBCOOL Rem No. Iem 1 of 1
Customer Order

Detalls

Hire of hall 500.00 500.00 0.00

To Delete an Invoice or Credit Note
1. Invoices and credits » choose the invoices or credit notes you want to delete » Delete.
2. To delete the invoice or credit note » Yes.

If any of the invoices or credit notes selected haven't been printed or posted the software
displays a warning message and you're prompted to confirm deletion once more.
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6.6 Customer Receipts

Customer receipts can be recorded in the customer ledger by selecting Customer Receipt
from the Bank Accounts module or the Customers Module.

Or Bank Account

The upper part of the screen is used to select the:
a) bank receiving the payment,

b) the customer account number,

c) the payment date,

d) amount being paid and

e) the payment reference for the transaction.

The reference and date are very important, especially if there are several payments that
need banking on the same day. We recommend using the same date and reference for all the
individual payments listed in the same paying-in slip. This allows the bank reconciliation to
group the transactions as one paying-in entry.

To activate grouping, select Settings » Bank Defaults and tick the Group Items in Bank
Rec box
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T2 Customer Receipt - Current Account 1

Section 6: Customer Module

I I 9 N ®2 H & @

Clear Payby Payin Wizard Automatic Department Print list Send to
form  card full (F3) Excel

Bank Details Customer Details Receipt Details
Bank A/C 1800 v AR LBCOO1 v Date* 07/11/2025
Name Current Account 1 Name Local Badminton Club Fafarance
Balance 19010.00 Balance 0.00 Ex. Reference
Amount 500.00 *
Show Al v

17 81

LBCO01  07/11/2025 07/12/2025 1

Hire of hall 0.00

Analysis Total 500.00

CO TABLE OF CONTENTS
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6.7 Customer Statements

Sending your customers statements on a regular basis is a good way of keeping them
informed, and it can also gently remind them that their payments are due or overdue.

To generate customer statements

1. Customers » select the required customers » Statements.

2. Layouts » select the statement layout you want to use.

3. From the report browser toolbar, click the action you want to take, for example, Print or

Preview.

4. |If a Criteria window appears, enter any required criteria » OK.

~.— Tip:

If you want to exclude any future sales receipts and sales payments on
account from your statement, select the Excl. Later Payments check box. This
gives you the flexibility to run retrospective statements - that is to include or
exclude invoices, depending on the payment date.

View available statement options

Ad A4 statement layouts are designed for use with laser printers.
Individual or If you select a statement including the Individual option, each transaction
Grouped appears on a separate line in your statement.
If you select a statement including the Grouped option, transactions which
were entered as a group, appear as a group transaction on a single line.
2 Part or Tear Off | Two Part statement layouts print your statement on the top sheet and your
remittance on the carbon sheet below.
Tear off statement layouts print your statement and remittance side by
side on a sheet.
O/S Only or To show only outstanding transactions on your statements, choose a
statement layout including the O/S Only option.
To show all transactions on your statements, choose a layout including the
Al All option.
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6.8 Customer Activity

This is a great way to view the history of trading between you and your customer. It also shows
the customer’s credit limit and balance as well as the total amount they have paid and the
turnover for the year.

A summary of dealings you have had with the customer appear in a list. Each line in the list
represents a transaction such as an invoice or payment.

To view the activity:

Customers » double-click the required record > Activity.

To filter the transactions which appear:

Show drop-down list 2> choose the criteria you require.

If you choose Custom Range, a further window appears where you can define a transaction
number range, date range and transaction type. The selections you make here are shown in
the boxes alongside the Show drop-down list.

To view or hide the breakdown of the selected transaction:
Click the Show Detail / Hide Detail button.

Show Detail opens a window breaking down any selected transaction into its component
parts. For example, a sales receipt is broken down into the invoices it paid off, where as a
sales invoice lists any receipts allocated against it. Hide Details closes the window showing
the detailed breakdown.

The Activity window

A/C This shows the customer account reference.

Name This shows the name of the customer.

Credit Limit This shows the credit limit entered in the Credit Control tab.

Balance The current balance of the customer account.

Amount Paid Total receipts from this customer.

Turnover YTD The year to date turnover value for this customer. This value is net of VAT.
The YTD figure is taken from the Sales tab and clears when you run the
year end routine. The value can be manually amended in the Sales tab.

No The number of the transaction.

Type The following transaction types may appear:

S| = SalesInvoice
SR = Sales Receipt
SC = Sales Credit
SA = Sales Payment on Account
SD = Sales Discount
SP = Sales Payment
Date The date of the transaction.
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Ref The transaction reference.

Details Any details entered for the transaction.

Amount The value of the transaction.

0/S The amount of the transaction that is still outstanding.
Debit If the transaction represents a debit, itis shown here.
Credit If the transaction represents a credit, it is shown here.
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6.9 Unallocate a Receipt
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If you have posted a receipt or credit against an invoice in error, you can use the “Unallocate”
option to unlink the transactions. A sales receipt (SR) becomes a payment on account (SA)

when it is unallocated, and it can then be allocated against a different invoice.

Show: All Transactions v Date: 301/01/1”0:031/12/2099 Type: 'All

AC V0 lype Details S
© 17S1  © 07/11/2025 07/12/2025 1 Hire of hall 500.00 500.00

500.00 to S117

07/11/2025 1 0

— X

© nel

B2 ® = &
Request card  Hide Print list Send to

payment detail et Excel

Balance EUR € 0.00

Amount Paid EUR € 500.00

Turnover YTD EUR € 0.00

o/Sonly [J Trans. 1to18
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6.10Credit Control

Credit control is essential and it is very important that the school knows who owes money.

The credit terms for each customer must be set in the Customer Record > Credit Control.

& Customer Record - Local Badminton Club = a X

© Help
1 BB & O R

Clear New New Delete Skype Google

form invoice order Maps
Details Terms Credit Review
Credit Limit 0.00 = AJC Opened 31/10/2025
Settlement Due 0 Days Last Credit Review [/ /
Alerts Sett.Discount 0.00 = Next Credit Review  / /
Communications Payment Due 09 Application Date /11
_ Payment Due From days after invoice date v Date Received /1
Activity Average Time to Pay 0 Days
Sales Trading Terms Text oo
Orders
Credit Ref. = a
Graph
Bureau v

Priority Customer O

Credit Position Reminder v

redit Limit [On Hol Y

Account status

DUNS Number

Restrictions

[Clcan charge credit  [IRestrict mailing
[“ITerms agreed v

The aged debt report will list all customers together with details of their outstanding debt. This is
printed from the customer module.

Flle Edit View Modules Settings  Connected services Tools Favourites  Weblinks Software updates

e L o B R D
Jedit Activity Batch Batch Customer Request card
- invoice credit receipt payment

The aged balance window appears showing the grand total of any outstanding invoices by ageing
period for each customer. To see the actual invoice details for these debts, highlight a customer
and press the Detailed button.
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i[ Aged Balances as of 7th November 2025

Q = &
Petailed Print list Sendto Reports
view Excel

Future

0.00

Aged Balance report date

Current 30 Days 60 Days

600.00 0.00 0.00

90 Days
0.00

Older
0.00

Include Payments Up To

600.00

Debtors
600.00

07/11/2025
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6.11 Customer Monthly Reports

As part of the month end procedures the following reports should be
printed and filed on a Customer Report file.

Day Books: Customer Invoices
Day Book: Customer Credit Notes
Day Book: Paid Invoices

Customer Activity Summary
Customer Activity Detailed

Sales Ledger Department Analysis
Aged Debtors Analysis Summary
Aged Debtors Analysis Detailed



Lock Period Date
Financial Reports

Board of Management and Finance Subcommittee Reports

Income & Expenditure Report with prior year to date

Report Checklist
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7.1 Lock Period Date

Once you have produced your monthly reports in Sage 50 Accounts, you can prevent
transactions from being posted before a set date, which means that no more transactions can
be posted back into earlier months

To enable this feature , select Settings >» Lock Date

The user can choose to override the blocking of transactions during transaction entry.
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7.2 Financial Reports

To help you make financial decisions it's essential for you to understand how the school is
performing. For an easy way to see this, there are several useful reports available in Nominal
codes including:

= Audit Trail Report

= Trial balance report

= Nominal Activity Report

= Balance sheet report

= Income and Expenditure report

= Budgetreport

You can start reporting on your transactions as soon as you enter them into your software.

The recommended reports can be stored as favourites in Sage.

To generate a financial report
1. Nominal codes » Reports.

A ’

~ - Tip:
’Q‘ You can also access some of these reports from the Nominal codes toolbar,
- for example, Profit & loss.

Select the required report area, for example, Nominal budgets.
Select the report you want to run, for example, Budget Report.

Report browser toolbar > click the action you want to take, for example, Print or Preview.

o~ W N

If a Criteria window appears, enter any required criteria 3 OK.

~ - Tip:
—!~ To make this even easier, you can add reports to Favourites.

Nominal code reports == = ]
l@ HE § % %E% Filters Al -
e . Delete = _ - — S
Favourites Favourites
Balance sheet Add the documents that you use most often to Favourites to access and generate them quickly. Documents
are added and removed by clicking the staricon. You can drag and drop your favourites into any order you
Day books want.

My nominal code reports
Nominal activity
Nominal budgets

»

Name Desaription Last Run Filename

Can only be run for
whole months as it

uges the nominal

Nominal details ¥ Balance Sheet record values, as 27/05/2015 16:45
" displayed in the

Profit and loss details tab of the

Trial balance nominal record.

Lists all nominal
codes, and every

Nominal Activity - Exduding No transaction, but 5
W Transactions erdirios those rodes 02032016 1133 NOMACTX
with no transaction
activity.

Displays the debit or
credit balance for

1 Nominal Balances each nominal code, 08/12/2015 13:30 NOMBAL
induding codes with
no balance.

All journal

" Day Books: Nominal Ledger ol

08/12/2015 13:28 NOMDAY

Actuals, budgets and

prior year values for
Rinminal Darnrd Vahise aarh manth incidine MAMUALS
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Audit Trail Report

Section 7: Reports

The audit trail is a list of transactions entered into Sage 50 Accounts. The Software
automatically allocates a sequential number and type to each transaction. To run the Audit
Trail report select Transactions and click Audit trail report from the toolbar.

Customers E

B B B H

Quotations Audit tral Accounts Verification | Edit Unallocate Delete | Send to Reports
s report audit reports Excel
ales orders
Invoices and credits E“ Filter ‘ | Find | ‘ 2442 |Q O All record
No 4 |Type|! |Neminal  |Dept |Details
Supplers 337 8P 1800 5010 0 2015-2064
Purchase orders 338BP 1800 5010 0 2015-2065
339BR 1800 1950 0 2015-2016
Products and services 340 BR 1300 2320 i} 2015-2017
341BR 1800 2440 0 2015-2018
- 342BR 1800 3010 0 2015-2019
) 343BR 1800 3020 0 2015-2020
Mominal codes
344BR 1800 3050 0 2015-2023
345BR 1800 3100 0 2015-2024
346 BR 1300 3130 0 2015-2025
347BR 1800 3240 0 2015-2026
e sty 348ER 1800 3250 0 2015-2027
Departments 349 B 1800 3275 0 2015-2028
IS0BR 1800 3200 0 2015-2029
There are four types of Audit Trail
Audit Trail Report | = |
Audit Trail Type DOutput
{®)Brief { JPrinter
{:}Summar}' OPreuiew
()Detailed (®)File
{)Deleted Transactions { JEmail
[ ]Landscape Output Run Cancel
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The summary audit trail shows full details of each transaction.

[m3 Audit Trail (Brief) - Preview — O
5 = o i Y 1
1 2 3 4 5 6 7 8
Date: 07/11/2025 FSSU Master Chart of accounts New Page: 1
Time: 16:25:17 Audit Trail ‘Brie_fl
Date From: 01/01/1980 Customer From:
Date To: 31/12/2050 Customer To: 77777777
Transaction 1 Supplier From:
Transaction To: 99,999,999 Supplier To: 777772777
Exclude Deleted Tran: o
No ItemsType A/C Date Ref Details Net Tax Gross
1 1 BR 1800 30/06/2025 DES ICT Grant 22,500.00 0.00 22,500.00
2 2 BP 1800 01/08/2025 Datapac Laptops 15,180.00 0.00 15,180.00
= 4 1 BR 1800 01/08/2025 Doc 3 TY Income 25 26 590.00 0.00 590.00
5 1 BR 1800 01/06/2025 DES TY Income 25 26 22,500.00 0.00 22,500.00
6 1 JC 1800 01/08/2025 TRANS Bank Transfer 200.00 0.00 200.00
7 1 ID 1850 01/08/2025 TRANS Bank Transfer 200.00 0.00 200.00
8 1 JD 5010 31/08/2025 Caretakers 650.00 0.00 650.00
9 1 JC 2250 31/08/2025 650.00 0.00 650.00
- 10 1 BP 1800 01/08/2025 123 Joe Bloggs Repairs 8,000.00 0.00 8,000.00
11 1 JC 2260 01/08/2025 Joe Bloggs VAT 1,350.00 0.00 1,350.00
12 1 JC 2270 01/08/2025 Joe Bloggs RCT 2,000.00 0.00 2,000.00
13 1 JD 5310 01/08/2025 Joe Bloggs VAT RCT  3,350.00 0.00 3,350.00
14 1 Pl DOHOO1 31/10/2025 Books 3,700.00 0.00 3,700.00

Itis recommended that you use the transaction number range rather than the date range
as this avoids the omission of transactions.
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7.3 Board of Management and Finance
Subcommittee Reports

A full set of reports should be generated at least 3 days before the scheduled board meeting.

The following reports and supporting documentation should be provided in advance to the
finance sub-committee:

1. Balances on all school bank accounts

2. Bank reconciliation statement for each bank account including outstanding
payments/receipts

Payments and receipts listings for each bank account
Income and expenditure account showing actual versus budgeted figures

Balance sheet

3
4
5
6. List of all creditors/outstanding invoices/accruals
7. Supplier invoices and statements since the last committee meeting

8. Summary of income/grants received in advance for the next school year
9. List of prepayments

10. Gross to net payroll reports since the last committee meeting

11. List of employees showing their approved gross annual/weekly/monthly/
hourly pay

12. Capital income and expenditure account report
13. Bank Statements

14. Credit card statement and supporting documentation approved by the
chairperson.

15. Nominal/general ledger activity report
16. RCT & VAT returns since last committee meeting

17. FSSU Financial Guidelines issued since last committee meeting
The following reports should be provided to the board of management:

1. Balances on all school bank accounts

2. Bankreconciliation statement for each bank account including outstanding
payments/receipts

Income and expenditure account showing actual versus budgeted figures
Balance sheet
List of all creditors/outstanding invoices/accruals

Summary of income/grants received in advance for the next school year

N o o & w

Capital income and expenditure account report
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7.3.1 Bank Account Balances

A list of all the schools bank accounts together with their balances and last reconciled date
can be printed from Sage 50 accounts.

Fle Edt View Modules Settings Connected services  Tools Favourites Weblinks  Software updates  Help

Home © el
s P & @ % B R M WME SE R U BR O @ 5 o= B

New/edit Actvity Reconcle Bank Payments Customer Bank Supplier Recurring Cash Depost Cashflow Download Delete Clear Printlist Sendto Statements Cheques Reports
. recel Excel

- tranfer o receipt receipt refund  items register cash
Customers
Sk T s Include inactve [
Suppliers

G coount 1
Current Account 2
Current Account 3
1803 DSP School Meal Bank Account

1810 Deposit Account 0.00

Bank feeds 1820 Parents Council/Assodiation Bank Account 0.00
1850 Credit Card Account 0.00

el ke 1870 Online Payment Solution Clearing Account 0.00

T 1900 Petty Cash Account 0.00
1950 Cash Control Account 0.00

Departments

Diary

Columns can be selected to include bank reconciliation details.
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7.3.2 Bank Reconciliation Statement

The bank accounts must be reconciled each month and the Bank Reconciliation report
printed for each account. Copies of the Bank Reconciliation reports must be included as part
of the reports for the Board.

&f2 Reconcile - 1800 - Current Account 1 — O X

A B B 8 & &8 w a & ™ &

View Report Bank Bank Customer Supplier Customer Supplier Bank  Print list Send to
history receipt payment receipt payment refund refund transfer Excel

ave time on bank reconciliation with Ban eds. Find out more

Statement reference 1800 2025-11-13 01 P End date 30/11/2025

Un-matched transactions

0.00
O/Bal Last reconciled balance 18510.00 0.00
07/11/2025 18 Sales Receipt 500.00 19010.00 :
A
v
Swap
Matched transactions
Book Balance Total Payments  Total Receipts Matched Balance — Statement Balance = Difference
19010.00 0.00 500.00 19010.00 \ 19010.00 0.00
l Save progress ” Recondile H Close
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7.3.3 Income and Expenditure Account

The income and expenditure account summaries the schools activity for the period specified
in the report.

Select Nominal codes / Reports / my nominal code reports / BOM Income & Expenditure
Account

Select the appropriate dates from Month 1 to month being reported on

Criteria for BOM Income and Expenditure Account x

Criteria Values

Enter the values to use for the criteria in this report

Period Between (inclusive) | [1: September 2024  +| and |12 August 2025 =]

Chart of Accounts fis | |2Fssu -l

Preview a sample report for a specified number of records or transactions (0 for all) ||] 3:

Help | oKk | Cancel |

Click OK
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7.3.4 Balance Sheet Report

Section 7: Reports

The balance sheet report is a snapshot of the school’s financial position at a single pointin

time.

Select Nominal codes / Reports / my nominal code reports / BOM Balance Sheet

Criteria Values

Enter the values to use for the criteria in this report

IE&tween linclusive) LI IEmught forward 3: Z{LI and |12: August 2025 LI
Brought forward 9: 2024 Y
| [1: September 2024 I

Period

Chart of Accounts s
2: October 2024
3: November 2024

Criteria for BOM Balance Sheet >

Preview a sample report for a specified number of re| 2D her 2024 )] ||] 3: N
5: January 2025
&: February 2025
Help | 7- March 2025 v 0K I Cancel |
I
T —
Select the appropriate dates from Brought Forward to month being reported on
Click OK
167
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7.3.5 Trial Balance

The trial balance is a list of all nominal records that have a balance at the period date
requested. It is a checking report and its main purpose is to make sure that the sum of all debit
balances equals the sum of all credit balances.

|B{ Period Trial Balance - Preview = O

Print 1E I " Report to Excel "¥ Data to Excel up L% Printer Lz Edit Close age |1

Date: 07/11/2025 FSSU Master Chart of accounts New Page: 1

e :16:33:44 Period Trial Balance

To Period: Month 12, August 2025

N/C Name Debit Credit
0 1461 Capital: ICT Additions 15,000.00

1800 Current Account 1 22,210.00

1850 Credit Card Account 200.00

2100 Creditors Control Account 5,600.00

2105 School Income Received in Advance 590.00

2250 PAYE/PRSI/USC/LPT Control Account 650.00
" 2260 Reverse VAT Control Account 1,350.00

2270 RCT Control Account 2,000.00

3921 DE ICT Grant Capital Income 45,000.00

4410 Non Capital Computers / ICT Expense 180.00

4731 Free schoolbook grant expense 5,600.00

5010 Caretaker Wages Expense 650.00
- 5310 Repairs to Buildings and Grounds Expense 11,350.00

L 2190.90 22190.90

If the totals on your trial balance do not balance this may indicate that your data is corrupted.
To investigate, run the Check Data rotine from File 3> Maintenance » Check Data

Each value is drillable. Click on the value of the account and it will drill to that accounts
nominal activity to display where the figure has been drawn from.
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7.3.6 Nominal Activity Report

This report lists all the nominal codes showing the current balance and the transactions for

dates selected.

Nominal Codes » Reports. Nominal Activity

Criteria for Nominal Activity - Excluding No Transactions

Criteria Values

Enter the values to use for the criteria in this report

Nominal Code Between v ~ond |

Transaction Dote Between(nclusive) v (01092025  v|end [MNNER -],
Transaction No Between (inclusive)  ~ [1 =] and [99999999 = |
Inc B/Fwd Tran .

Preview a sample report for a specified number of records or transactions (0 for all) [0—3

Help II' —IO"“'

Do not select Inc B/Fwd Tran

Section 7: Reports

Preview
I 1 1 =
1 i 2 3 "4 | 5 {1 6 | (0 0 |
Date: 07/11/2025 FSSU Master Chart of accounts New Page: 1
Time: 16:36:27 . a2 oS A
Nominal Activity - Excluding No Transactions
Date From: 01/09/2025 N/C From:
Date To: 30/11/2025 N/CTo: 99999999
Transaction From: 1
Transaction To: 99,999,999
& N/C: 1700 Name:  Sales Ledger Control Account Balance: 600.00 DR
No Type Date Account Ref Details Dept T/C Value Debit Credit V B
i 17 SI 07/11/2025 LBCOO1 1 Hire of hall 0 ™ 500.00 500.00
18 SR 07/11/2025 LBCOO1 Sales Receipt 0 T 500.00 500.00 N
- 19 SI 07/11/2025 LBCOO1 0 ™ 600.00 600.00
:;- Totals: 1,100.00 500.00
¢ History Balance: 600.00
, N/C: 1800 Name:  Current Account 1 Account Balance: 19,010.00 DR
1 No Type Date Account  Ref Details Dept T/C Value Debit Credit V B
; 15 PP 31/10/2025 DOHO01 Purchase Payment 0 T 3,700.00 3,700.00 - R
= 18 SR 07/11/2025 LBCOO1 Sales Receipt 0 T 500.00 500.00 “ N
Totals: 500.00 3,700.00
- History Balance: 3,200.00
: N/C: 2100 Name: Creditors Control Account Account Balance: 5,600.00 CR
n
. No Type Date Account  Ref Details Dept T/C Value Debit Credit V B
1s o a3 naunns Dol o To 220000 230000

CO TABLE OF CONTENTS

169



FSSU SAGE Accounts Manual

7.3.7 List of Creditors

Schools using the Supplier Module should print an aged creditors report
Click suppliers » reports » Aged Creditors Analysis (summary)

Open the report and enter the relevant dates. Run the report

Section 7: Reports

Date: 07/11/2025 FSSU Master Chart of accounts New Page: 1
Time: 16:38:45 Aged Creditors Analysis (Summary)

Report Date: 30/11/2025 Supplier From:

Include future transactions: No Supplier To: zZzzzzz

Exclude Later Payments: No

** NOTE: All report values are shown in Base Currency, unless otherwise indicated **

AJC Name Credit Limit Tumover Balance Future Current  Period1l Period2  Period 3 Older
DOHO01  Doherty Book Suppliers € 0.00 5,600.00 5,600.00 0.00 0.00 0.00 0.00 5,600.00 0.00
Totals: 560000  S800.00 000 000 000 00 Se00.00 00

List of Accruals

Schools using the Bank Module only must list all invoices outstanding.

Prepayments

Alist of monies paid in advance must be listed e.g. Insurance

Income received in advance

Many schools request advance payments from incoming first year and other students.

Detailed records must maintained and a summary of the advanced income prepared for the

Board.
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7.4 Income & Expenditure Report with prior year to
date

There is a report format for an Income and Expenditure report that will generate the prior year
accounts figures on a year to date basis on our website here.

About Us | Circulars |

| Search

Training Guidelines
v v

< Profit & Loss Report File (budgets vs actuals) 1 year
Covid-19

Guide on installing BOM reports
Fundraising and Donations

Guide on running BOM reports
Grants

Import Templates
Internal Financial Controls
Supplier Record Import Template

Interview and Selection Committees
Customer Record Import Template
Miscellaneous Audit Trail Transaction Template

Monthly Financial Reporting Optional Reports
Income & Expenditure Report with prior year to date

OLCS

Guideline for installing report

This report is optional for reporting purposes and is not a replacement for the existing Board
of Management Income & Expenditure report which is recommended for the monthly Board
meetings. The instructions for copying the report across to the Sage 50 accounts package follow.

Steps for installation (This will need to be done just once).

1. Open Sage 50 Accounts for your school.

2. Create afolder on your desktop and label it: BOM SAGE 50 customised reports
3. Download the report from our website as highlighted above
4. Double click the report file
5. Enter your Sage login details, Manager and Password.
File Edit View Toolbox Sections Report Format Tools Help
HS VB0 00 &% eSS X
A2 (None) z - v Bl U O A it (SLUSLEL S Sl
Ls Poin&ﬁAddTea \ Draw Line [} Draw Box | Add Image /Logo &} Add Data Field
3 040 1 1200 1 1300 1 40« 1 50+ 1 60+ 1 1704 1 (801 | 190+ | 1100+ | 110+ | 11201 | 1130+ | +140+ | +150: | 160+ | 170+ | 1180 | 1150 | 200 I]i2]
| 3 1. Page Header EM®
% D_ate: DATE NAME Page: PA
2 Time: TIME NAME
2 From: (CRITERIA.TRAN_PERIOD_FROM To: (CRITERIA.TRAN_PERIOD_TO
= Chart of Acoounts:  NAME
3 2 Page Header WX
EI Period Budget Difference Prior Year
3. CATEGORY Header [~
I:l TITLE
4. CATEGORY.SORT_ORDER Header (|
EI NAME
5. Details
D ACCOU  NAME PERIOD.NOMINAL  PERIOD.NOMINAL PERIOD.NOMINAL  PERIOD.NOMINAL_P
6. CATEGORY.SORT_ORDER Footer A E}El
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The report opens then click File > click save as
The file will save in My Nominal Reports

Please type in the following file name ‘Income & Expenditure Account comparative prior
year period’-click Save.

9. Click exit - to return to Sage 50 home screen.

10. To view the report Click Nominal codes > Reports > My nominal code reports

Favourites My nominal code reports
Balance sheet

clean up
Day books
=
Nominal activity
Nominal budgets v BOM Income and Expenditure Account
Nominal details
Profit and loss

Trial balance /' BOM Balance Sheet

% Income and Expenditure Account period comparatives

11. To generate the report click on Income & Expenditure Account period comparatives

Criteria for Income and Expenditure Account period comparatives

Criteria Values

Enter the values to use for the criteria in this report

Period Between (inclusive) 1 September 2024 ~ ond 12 August2025 v
Chart of Accounts Is 2. FSSU v |
Preview a sample report for a specified number of records or transactions (0 for all) Io 3

Help |

Select the period for the report, example between:
1: September 2024 and 12: August 2025 and Chart of Accounts: 2: FSSU

12. For the report to appear in Favourites, click the star button against the report and it will
change to orange and for future will show in the favourites list when nominal codes >
reports are selected.
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7.5 Report Checklist

Reporting

Favourite Report. Use favourite reports to quickly find reports that you use regularly. Right-
click the report and choose Add to Favourites.

When running reports the dates can be entered or you can select the preset range by clicking
the icon beside transaction date

Bank reports 1. BankPayments
Bank Receipts

Unreconciled Bank Transactions

W N

Bank reconciliation report — print within Bank
Reconciliation section

Audit Trail Report

Trial balance report

—_

Nominal
Reports
Nominal Activity Report
Balance sheet report

Income and Expenditure report

S T o

Budgetreport

—y

Creditors
Reports

Daybooks: Supplier invoices detailed

N

Daybooks: Supplier Credit detailed

w

Daybooks: Supplier Payments- print from the Bank
Module

Creditor Activity Summary
Creditor Activity Detailed
Aged Creditors detailed
Aged Creditors Summary

N o o~

Customer 1. Day Books: Customer Invoices
Reports Day Book: Customer Credit Notes
Day Book: Paid Invoices

Customer Activity Summary
Customer Activity Detailed

Sales Ledger Department Analysis

Aged Debtors Analysis Summary

© N oA W N

Aged Debtors Analysis Detailed
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Board of 1. Balances on All School Bank Accounts

Management 2. Bank Reconciliation Statement for each Bank Account

including cheques and Lodgements listings

3. Income and Expenditure Account showing actual versus
budgeted figures

4. Balance Sheet

List of all creditors / List of accruals / Summary of income
received for next school year and prepayments

6. Capital Income and Expenditure Account (Prepare
manually)

Year End 1. Trial Balance
Reports Nominal Activity
Audit trail

Income and Expenditure
Balance Sheet

Bank reconciliation report

Unreconciled receipts and payments

©® N O oA W N

Aged Suppliers list-detailed (only for schools using the
Supplier module)

9. Aged Customer list-detailed (only for schools using the
Customer module)




Introduction

Preparation for year end

Running the Financial Year End
Check After Running the Year End

Understanding The Year End Routine

Posting Transactions after the Year End

Financial Year End Reports
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8.1 Introduction

Sage 50 Accounts works on a 12 month accounting period, referred to as the financial year.
You entered this in the Active Setup wizard when you set up your school.

It's really important to make sure this date is correct as when you record transactions their
values update to an accounting period on your nominal accounts based on your financial year
date and the transaction date. Sage 50 displays a warning message when a transaction date
does not fall within the current financial year. At that point you can choose whether to post the
transaction to your accounts or not.

At the end of the 12 month period you run the year end to change this date for the new
financial year

The year end process moves the total value on each Income and Expenditure nominal code
into the retained earnings nominal code, on the last day of the financial year. You can also set
up the budgets for the next financial year, and take an archive copy of the data as it is before
you run the year end.
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8.2 Preparation for year end

Before running your year end, ideally you should post all day-to-day transactions for the
year. This ensures that your management reports and year end postings are as accurate as
possible.

= All payments and receipts

= Reconcile all Bank Accounts

= All purchase invoices, credit notes and payments
= Correctall errors

= Allyear end adjustments should be posted (Income received in advance etc.)

Print out Financial Reports

Run the check data — make sure to correct any reported errors before processing the
Year End option.

Check the chart of accounts - this program will check the chart of accounts to establish
which nominal codes are income and expenditure codes. This will ensure no nominal
codes are missed.

Change the program date — change the program date to be the last day of the financial
year.

Take TWO backups labelled ‘Before Year End’ - it is essential to back up the data
before running the year end, as this is the only way to go back to a pre-year position. It
is advisable to take two backups as a precaution against loss or damage of the backup
media.

Archive Data - select the option to archive data. This will enable you to view old data
without having to restore old backups.
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8.3 Running the Financial Year End

To run the year end select Tools > Period End > Year End.

This will display the year end window as shown below:

Year End

Year End for 1st September 2024 to 31st August 2025

Prepare for Year End

Detect and correct any data problems.
Check Chart of Accounts for any omissions.

Take a backup now to make sure your data is

Archive your data in case you need to refer to it in the future. Archives
can be viewed as Read-only data later.

Year End Options

Base next year's nominal or stock budgets on current year actual or 0O
budget values.

The date to appear on the year end journal (last day of the current year)
transferring profit and loss balances to retained earnings.

(usually the first day of the new financial year).

Run Year End

Running Year End for 31/08/2025 will:

- Change your financial year to 01/09/2025 - 31/08/2026.

- Transfer balances from all profit and loss accounts to retained

- Set the profit and loss nominal accounts for the new financial year to
- Archive your data.

The Year End will clear all Profit/Loss Nominal Codes to Retained Earnings and optionally
create next year's budgets. You can post transactions to any time period without running a

®
E

Check Data

Check COA

Backup

31/08/2025

Prevent new transactions from being entered before this date o7/

Archive Location

Budget Options

I Run Year End || Cancel |

Check the details shown at the bottom of the Year End window are correct before

selecting the Run Year End option.

Confirm

Do you want to continue?

@ You are about to run your Year End for 01/09/2024 to 31/08/2025.

Click YES if the year end dates are correct.
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A year end progress screen will appear. Once complete you will be asked if you would like to
print the Year End Journal Report. It is important to print the year end journal report.

Year End Report ™ ]
Qutput
II' (%) Printer
Preview
e

A final message appears that the financial year end has been completed, click OK.

a Sage 50 Accounts Client Manager - FSSU Master Chart of accounts New Dataset 2024 2025
(W3 Year End Report - Preview - (m}
= 5 1
Voo 1 2 3 4 5 6 7

Date: 07/11/2025 FSSU Master Chart of accounts New Page: 1
Time: 17:12:35 Year End Report
No Items Type A/C Date Ref Details Net Tax Gross
20 1 JC 4410 31/08/2025 Ledger Ledger Year End 180.00 0.00 180.00
21 1 JC 4731 31/08/2025 Ledger Ledger Year End 5,600.00 0.00 5,600.00
22 1 JC 5010 31/08/2025 Ledger Ledger Year End 650.00 0.00 650.00

- 23 1 JC 5310 31/08/2025 Ledger Ledger Year End 11,350.00 0.00 11,350.00
24 1 D 2710 31/08/2025 Ledger Ledger Year End 17,780.00 0.00 17,780.00
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8.4 Check After Running the Year End

Run a Brought Forward trial balance. Select Modules *> Nominal codes > Trial Balance >

select brought forward under Period

Criteria for Periad Trial Balance L= ]

Criteria Values

Enter the values to use for the criteria in this report

Section 8: Year End Procedures

pored Foamer -]

Preview a sample report for a specified number of records or transactions (0 forall) |0 El
Date: 12/11/2025 FSSU Master Chart of accounts New Page: 1
P e Period Trial Balance
To Period: Brought forward
N/C Name Debit Credit
1461 Capital: ICT Additions 15,000.00
1800 Current Account 1 22,210.00
1850 Credit Card Account 200.00
2100 Creditors Control Account 5,600.00
2105 School Income Received in Advance 590.00
2250 PAYE/PRSI/USC/LPT Control Account 650.00
2260 Reverse VAT Control Account 1,350.00
2270 RCT Control Account 2,000.00
2710 Surplus Brought Forward 17,780.00
3921 DE ICT Grant Capital Income 45,000.00

Ao 22,120.00 22120.00

Make sure there are no income and expenditure codes on this report

Next, Check your data again. File » Maintenance » check Data

Finally take another backup of the data and label it ‘After Year End’
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8.5 Understanding The Year End Routine

Income and Expenditure account balances are cleared and the year to date figures on these
codes are transferred to the retained earnings nominal code using journals.

Balance Sheet balances are brought forward to the new financial year and included in the
year to date values on the balance sheet report.

The audit trail is updated with the ledger year end journals that are posted to clear the income
and expenditure accounts.

The Nominal Records are updated with the actual monthly balances for the current financial
year transferred to the Prior Year column. Any future transactions in the previous year
become current year actuals

Supplier Records are updated - the values in the YTD fields on all suppliers are transferred
to the prior year field. Any future dated transactions are transferred into the relevant monthly
field in each supplier

Customer Records are updated - the values in the YTD fields on all customers are
transferred to the prior year field. Any future dated transactions are transferred into the
relevant monthly field in each customer.

The Financial Year start date is moved to the next financial year end.



FSSU SAGE Accounts Manual Section 8: Year End Procedures

8.6 Posting Transactions after the Year End

= Of course, there may be the occasional transaction that you need to enter after you run
your year end that relates to the previous year.

= Ifthis happens, you can still post late entries back into the previous year. If you know the
approximate value of these late entries before you run the year end, you can also post
transactions known as accruals to reflect their value in your year end figures.
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8.7 Financial Year End Reports
As part of the year end procedures the following reports should be printed and filed.
= Trial Balance
= Nominal Activity
= Audit trail
= Income and Expenditure
= Balance Sheet
= Bank reconciliation report
= Unreconciled receipts and payments
= Aged Suppliers list-detailed

= Aged Customer list- detailed
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